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Sažetak

Fotometrija je jedna od temeljnih astronomskih metoda pomoću koje istražujemo Svemir.
U svojoj osnovi, astronomska fotometrija se svodi na mjerenje svjetlosti koja iz nebeskih
objekata dolazi do nas. Analizom takvih mjerenja otkrivamo razna svojstva zvijezda,
galaksija i drugih astronomskih tijela.

Ovaj priručnik namijenjen je učenicima, nastavnicima, mentorima i entuzijastima,
i ima za cilj pružiti upute kako napraviti prve najjednostavnije korake u fotometriji.
Pritom je za početak dovoljno imati samo fotoaparat, što je uobičajena oprema u ško-
lama. Mogućnosti se dodatno proširuju ako se posjeduje teleskop s praćenjem vrtnje
neba, ili uz to i astronomska kamera.

Iako je razina sadržaja pogodna za srednjoškolce i studente, priručnik će biti koristan
i mentorima za rad s osnovnoškolcima. Pretpostavka je da čitatelj nema veliko pozna-
vanje astronomije, pa se stoga u prvom dijelu priručnika prolazi kroz osnovne teorijske
koncepte relevantne za fotometriju. Zatim su opisane upute kako koristiti fotoaparat za
snimanje neba i prikupljanje podataka, kao i kako obraditi slike u astronomskim pro-
gramima, uključujući i upute kako napraviti fotometrijska mjerenja. U zadnjem dijelu
priručnika dajemo niz praktičnih primjera fotometrijskih projekata koji se mogu odraditi
koristeći znanja i tehnike opisane u ovom priručniku.
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Poglavlje 1

Uvod

Cilj ovog priručnika je omogućiti prve praktične znanstvene korake u as-
tronomiji kod učenika, nastavnika, studenata, i općenito entuzijasta.

1.1 Što je to astronomska fotometrija

Ukoliko vas privlači bavljenje astronomijom, možete joj se posvetiti iz dva jednako uzbudljiva
smjera: estetsko-umjetnički, gdje savladavate tehnike kojima težite stvoriti što upečatljivije
snimke svemirskih ljepota, ili znanstveno-analitički, gdje vaše oko ili kameru tretirate kao
mjerni instrument i težite vještinama analize podataka koje tako prikupite.

Ukoliko vas intrigira zakoračiti u ovu drugu skupinu, onda je dobar prvi korak upozna-
vanje s astronomskom fotometrijom. Fotometrija se bavi mjerenjem količine svjetla koje
dolazi do oka, a astronomska verzija toga je mjerenje svjetla pomoću instrumenata poput
današnjih digitalnih kamera.

Strogo govoreći, cilj vam je izmjeriti gustoću toka zračenja (astronomi to na engleskom
nazivaju flux density ili jednostavno samo flux), tj. energiju koja prolazi kroz jedinicu
površine u jedinici vremena (W/m2, u hrvatskom ćete pronaći i nazive ozračenje ili iradi-
jancija). Drugim riječima, interesira vas koliko je energije prikupio piksel kamere tijekom
vremena trajanja prikupljanja svjetla na senzoru (ekspozicija, tj. fotografi bi rekli tijekom
„brzine zatvarača“). Primijetite da koristimo izraze svjetlo i zračenje: u biti, radi se o
jednom te istom, ali pod svjetlo mislit ćemo prvenstveno na oku vidljivo zračenje, a pod
zračenje mislimo na općenito bilo koju valnu dužinu (tj., energiju) fotona.

Tu se odmah susrećemo s prvom ključnom razlikom između umjetničke i analitičke
fotografije svemira. Ako vam je cilj stvoriti što ljepšu sliku, onda ćete raznim tehnikama
proizvoljno mijenjati vrijednosti piksela ne bi li uspjeli istaknuti detalje koji vas zanimaju.
To onda zovemo astrofotografija. Ali ako vas zanima koristiti kameru kao mjerni instru-
ment, onda je imperativ očitati stvarne vrijednosti piksela, bez estetskih manipulacija,
ne bi li dobili informaciju o količini svjetla koje je pristiglo iz svemirskog izvora kojeg
proučavamo (npr. neke zvijezde).

Fotometrija se u biti svodi na zbrajanje vrijednosti u pikselima (najmanjim dijelovima
slike) koje je osvijetlila zvijezda. Velik problem je međutim da vrijednosti koje piksel ima
ne dolaze samo od sjaja zvijezde. Te dodatne doprinose nazivamo šum i izvori su raznoliki.

Velik doprinos dolazi od toga što samo nebo, tj. atmosfera, svijetli, posebice ako
snimate s neke lokacije koja ima osjetno svjetlosno onečišćenje. Razni zemaljski izvori
svjetla raspršuju se u atmosferi i stvaraju pozadinski sjaj neba kojeg zvijezda ili galaksija
mora nadjačati svojim sjajem da ju uopće i vidite. Ali čak i savršeno tamno nebo ima
neki sjaj, samo što je puno manji pa ćete stoga imati i više vidljivih zvijezda na vašoj slici.
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2 Uvod

Uz to, i sama kamera stvara vlastiti šum, što možete detektirati ako zatvorite objektiv
poklopcem i okinete fotografiju iste ekspozicije kao i kad ste snimali nebo. Takva tamna
fotografija neće imati vrijednosti nula u pikselima, čemu je uzrok sama kamera.

Uz sve to, dodatni problem je što sav taj šum varira od slike do slike. Šum može imati
i strukturu ako dolazi od prašine na senzoru ili objektivu, a i sam objektiv ili teleskop
stvara nejednoliko osvjetljavanje senzora kamere. Postoji čitava znanost iza toga što i
kako se sve generira šum i nepravilnosti na slici. U ovom priručniku ćemo se zadovoljiti
jednostavnijim metodama uklanjanja šuma i korigiranja slika. Time smo prihvatili i veću
grešku mjerenja, ali to će biti dovoljno dobro za započeti se baviti fotometrijom.

1.2 Kome je ovo namijenjeno i kako se snaći

Kao sa svim novim stvarima, najvažnije i najteže je uložiti početni trud i vrijeme. To
vrijedi i s ovim priručnikom. Cilj je omogućiti prve, vrlo jednostavne korake u astronom-
sku fotometriju, sa što manje komplikacija. Priručnik pruža nekoliko početničkih razina
znanja fotometrije, što je dovoljno za izvođenje mnoštva zabavnih opažačkih projekata iz
astronomije.

Priručnik je pisan s idejom da ga mogu pratiti srednjoškolci, mentori, i astronom-
ski entuzijasti bez bitnog predznanja iz astronomije. Kroz uvodna poglavlja čitatelj se
može upoznati s potrebnim minimalnim znanjima, ali isto tako nastavnici i mentori mogu
koristiti priručnik u svojem radu s osnovnoškolcima. Praktični primjeri idu od vrlo jed-
nostavnih, zamišljenih kao prvi koraci u fotometriju, pa do zahtjevnijih, gdje se upuštamo
u prava mala znanstvena istraživanja.

Ako se netko nakon ovog priručnika odluči upustiti još dublje u problematiku i pre-
cizniju fotometriju, postoje priručnici organizacije The American Association of Variable
Star Observers (AAVSO) koji su bili i početni korak u izradi našeg priručnika. Za takve
napredne astronome preporučamo njihove priručnike The AAVSO DSLR Observing Man-
ual1 ako snimate nebo fotoaparatom [5] ili (posebno detaljan) AAVSO Guide to CCD/C-
MOS Photometry2 ako snimate astro-kamerom [6].

Osnovni preduvjeti za korištenje našeg priručnika su:

• Minimalna prethodna znanja astronomije: fotometrija je alat za proučavanje Svemira,
tako da o puno novih stvari o astronomiji možete učiti i u hodu;

• Minimalna oprema: dovoljno je za početak imati fotoaparat, što škole uglavnom
danas imaju;

• Teleskop nije nužan, ali je koristan: teleskop vam otvara više mogućnosti za zaht-
jevniju fotometriju, ali to opet ovisi o tome ima li teleskop praćenje, a nakon toga
imate li možda i astro-kameru;

• Osnove matematike: astronomi rade s magnitudama, koje su u biti logaritamska
funkcija, tako da to morate savladati (iako kod osnovnoškolaca se mogu napraviti
vježbe gdje se ne ulazi u pojam magnitude i logaritma).

1https://www.aavso.org/dslr-camera-photometry-guide
2https://www.aavso.org/ccd-camera-photometry-guide

https://www.aavso.org/dslr-camera-photometry-guide
https://www.aavso.org/ccd-camera-photometry-guide


1.2 Kome je ovo namijenjeno i kako se snaći 3

• Korištenje računala: priručnik daje detaljne upute koje programe koristiti i kako u
njima napraviti mjerenja. To je dovoljno za početak, jer se s time mogu raditi i
napredni astronomski projekti. A ako ste vični programiranju onda vam se otvaraju
i dodatne mogućnosti.

1.2.1 Primjena u osnovnoj školi: 5 i 6 razred

Kod osnovnoškolaca je pretpostavka da se ovim priručnikom služe nastavnici ili mentori
koji rade s učenicima. Najvažnije je u tom slučaju procijeniti što od teorijskog predznanja
treba izbjegavati jer bi bilo konceptualno prezahtjevni. Na primjer, kod osnovnoškolaca
izbjegavajte logaritme, što onda znači i magnitude. Fotometriju zadržite na vrijednostima
sume piksela bez da nakon toga uzimate logaritam i pretvarate to u magnitude.

Naš prijedlog redoslijeda tema za početni rad s učenicima ovog uzrasta temelji se na
pretpostavci da će učenici koristiti fotoaparat:

poglavlje tema ilustracija
2.2 Što je to digitalna slika Slika 2.6
- Kako izgleda zvijezda na slici Slika 2.7
2.4.1 Bayerova RGB matrica Slike 2.9, 2.10
2.6.1 Tipovi pogrešaka -
3.1 Snimanje fotoaparatom bez teleskopa i bez praćenja neba Slike 3.1-3.5
3.3.1 Konverzija u FITS format -
2.1.5 Što je to srednja vrijednost i medijan -
4.1.1 Jednostavna fotometrija u programu SAOImageDS9 Silke 4.1,4.2

1.2.2 Primjena u osnovnoj školi: 7 i 8 razred

Kod starijih osnovnoškolaca proširujemo teme koje su spomenute za uzrast 5. i 6. razreda.
Sada već važnu ulogu počinju igrati matematičke vještine kod učenika. Fotometrija u
svojoj osnovi je zapravo primijenjena matematika, i raspon tema koje se mogu sada raditi
ovisi o tome koliko su učenici sposobni savladati razine koje nadilaze uobičajena školska
predznanja.

Predlažemo pokušati sa slijedećim temama (oznaka "Ekstra" označava dodatne napred-
nije teme):

poglavlje tema ilustracija
2.2 Što je to digitalna slika Slika 2.6
- Kako izgleda zvijezda na slici Slika 2.7
2.3 Ekstra: Zašto zvijezde nisu točke -
2.4.1 Bayerova RGB matrica Slike 2.9, 2.10
2.4 Ekstra: Važnost filtera u astronomiji Slike 2.11-2.13
2.6.1 Tipovi pogrešaka -
2.6.2,2.6.3,2.6.5 Ekstra: Izračuni pogrešaka fotometrije -
3.1 Snimanje fotoaparatom bez teleskopa Slike 3.1-3.5



4 Uvod

i bez praćenja neba
3.3.1 Konverzija u FITS format -
2.1.5 Što je to srednja vrijednost i medijan -
4.1.1 Jednostavna fotometrija u programu SAOImageDS9 Slike 4.1,4.2
4.2 Extra: Problem saturacije piksela Slike 4.3-4.4

1.2.3 Primjena u srednjoj školi

Glavni iskorak kod srednjoškolaca je da se mogu koristiti logaritmi (a time i magnitude).
Iako se u nastavi matematike logaritmi obrađuju tek sredinom srednje škole, neće biti
problem da i učenici na početku srednje škole savladaju koncept logaritama u poglavlju
2.1.2. Time čitav priručnik postaje pogodan za srednjoškolce, ali je pitanje kojim redosli-
jedom obrađivati ovako opširan sadržaj.

Naša preporuka je slijedeća:

• krenete s osnovnim redosljedom previđenim za 7. i 8. razred osnovne škole,
• nakon toga odradite sadržaje označene kao "ekstra" u tom popisu tema,
• posebnu pažnju posvetite izračunima pogreške u poglavlju 2.6,
• nakon savladavanja osnova fotometrije, krenite na naprednije teme kroz poglavlje

4.3.



Poglavlje 2

Početni pojmovi

Prije nego krenemo s fotometrijom moramo biti sigurni da razumijemo os-
novne pojmove i matematiku koja se pritom koristi.

Za napraviti prve korake u fotometriji nije potrebno vrlo napredno znanje iz as-
tronomije ili matematike. Ali s nekim osnovnim pojmovima se morate upoznati. Svi
su jednostavni i mogu ih savladati i osnovnoškolci. Naravno, sve ima i svoje komplici-
ranije verzije, pa je stoga uvijek moguće "zaroniti" puno dublje u fiziku i matematiku
svakog pojma s kojim se susretnete. Međutim, cilj ovog priručnika je da vam omogući
prve osnovne korake.

2.1 Potencija, logaritam, magnituda, indeks boje, medijan
i srednja vrijednost

Astronomija se temeljni na nekoliko ključnih matematičkih pojmova bez kojih se ne može
raditi fotometrija. Ako vam nisu poznati, lako ćete ih naučiti jer nisu teški. Ako neka
vježba u ovom priručniku traži dodatnu matematiku koja nije samo logaritam, magnituda,
medijan ili srednja vrijednost, objasniti ćemo je unutar te vježbe.

2.1.1 Potencije

Prvo krećemo od potencija koje su skraćeni zapis umnoška istih brojeva. Na primjer, ako
broj x množimo n puta sa samim sobom koristiti ćemo zapis x na n-tu potenciju:

xn = x · x · x...x · x · x︸ ︷︷ ︸
n faktora

(2.1)

gdje broj x zovemo bazom (eng. base), a n eksponentom (eng. exponent, index, power)
potencije. S ovakvim zapisom vjerojatno ste se susreli kod pisanja velikih brojeva gdje
koristimo bazu 10, poput:

10−9 = 0.000 000 001 = 0.1 · 0.1 · 0.1 · 0.1 · 0.1 · 0.1 · 0.1 · 0.1 · 0.1
10−2 = 0.01 = 0.1 · 0.1
10−1 = 0.1

100 = 1 (2.2)
101 = 10
102 = 100 = 10 · 10
109 = 1 000 000 000 = 10 · 10 · 10 · 10 · 10 · 10 · 10 · 10 · 10

5



6 Početni pojmovi

Inverznu operaciju potenciji zovemo korijen. Recimo kvadratni korijen, 2√100 = 2√10 · 10 =
2√102 = 10. Ili kubni (tj. treći) korijen, 3√1000 = 3√10 · 10 · 10 = 3√103 = 10. Pritom
kvadratni korijen pišemo uglavnom na pojednostavljen način 2

√
=

√
jer je jako često u

upotrebi. Primijetite sada poveznicu s potencijama na ovom primjeru: 3√1 000 000 000 =
3√109 = 3√1000 · 1000 · 1000 = 3√10003 = 1000 = 103 = 109/3. Ovo nam sugerira da
možemo pisati 3

√
x = x1/3.

Evo i općenitih pravila koja vrijede za potencije:

n
√

x = x1/n

(xn)m = xn·m

x−n = 1
xn

(2.3)

xn · xm = xn+m

xn

xm
= xn−m

x0 = 1

Međutim, potencije ne moraju imati samo cijele brojeve za bazu i eksponent. Evo primjera
nekih općenitih potencija:

100.5 = 101/2 =
√

10 = 3.16227766017...

1000.2 = 1001/5 = 5√100 = 102/5 = 2.51188643151...

100−0.2 = 10−2/5 = 1
102/5 = 0.39810717055...

1.52.5 = 2.75567596063... (2.4)
10π = 1385.45573137...

π−2 = 0.10132118364...

ππ = 36.4621596072...

2.1.2 Logaritmi

Što ako za neku bazu znamo rezultat potenciranja, ali ne znamo koji je bio eksponent?
Recimo, ako vas netko pita koji je eksponent potreban da bi koristeći bazu 10 dobili broj
1000, znate odmah da je to 3 jer je 103 = 1000. Matematički to onda zapisujemo kao
logaritam s bazom 10:

log10 1000 = log10 103 = 3

ili općenito ako za neku bazu x vrijedi y = xn onda je logaritam definiran kao:

logx y = logx (xn) = n (2.5)
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x y log x log y

0.001 1 -3 0
0.01 2 -2 0.301029996
0.1 4 -1 0.602059991
1 8 0 0.903089987
10 16 1 1.204119983
100 32 2 1.505149978
1000 64 3 1.806179974

Tablica 2.1: Primjer varijabli x i y koje imaju veliki raspon vrijednosti.

Evo nekih primjera logaritama koristeći primjere potencija iz jednadžbi 2.2 i 2.4:

log10 0.000 000 001 = −9
log10 100 = 2

log10 3.16227766017 ≈ 0.5
log100 0.39810717055 ≈ −0.2 (2.6)
log1.5 2.75567596063 ≈ 2.5
logπ 0.10132118364 ≈ −2
logπ 36.4621596072 ≈ π

Budući da je u praksi baza 10 najčešće u upotrebi, uobičajeno je pisati takve logaritme bez
oznake baze, tj. log10 = log. Uz to, u svijetu prirodnih znanosti pojavljuje se često baza s
brojem e, koji je konstanta (kao što je i broj π konstanta) koja iznosi e = 2.71828182846...
Logaritam s bazom e zove se prirodni logaritam i označava kao loge = ln.

Matematičke operacije s logaritmima slijede neka pravila:

logx 1 = 0
logx x = 1

logx(y · z) = logx y + logx z

logx

(
y

z

)
= logx y − logx z (2.7)

logx yz = z logx y

logx y = 1
logy x

logx y = logz y

logz x
(prelazak na novu bazu)

Zašto nam je logaritam važan? Zato što je svemir prepun primjera gigantskih razlika u
fizikalnim veličinama: udaljenostima između zvijezda i galaksija, sjaju svemirskih objekata
i njihovoj masi, itd. Stoga se pojavljuje problem kako baratati takvim skalama u praksi,
poput prikazivanja na grafikonu.

Pogledajmo to na primjeru izmišljenih veličina x i y čije su vrijednosti izlistane u tablici
2.1. Slika 2.1 prikazuje kako izgleda grafikon ako se koriste uobičajene koordinatne osi.
Zbog velikih razlika u vrijednostima, točke na grafu su uglavnom stisnute u maleni prostor
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Slika 2.1: Grafički prikaz odnosa između varijabli x i y iz tablice 2.1. Grafikon koristi obične linearne
koordinate osi.

Slika 2.2: Grafički prikaz odnosa između log x i log y iz tablice 2.1. Grafikon koristi obične linearne
koordinate osi.

Slika 2.3: Grafički prikaz odnosa između varijabli x i y iz tablice 2.1. Grafikon koristi logaritamske
koordinate osi.
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grafikona. Međutim, ako umjesto x i y grafički prikažemo log x i log y, vidimo jako lijep
graf koji prikazuje odnos i između vrlo malenih i između vrlo velikih vrijednosti od x i y
(vidi sliku 2.2. Ali možda sada niste zadovoljni jer na koordinatnim osima su vrijednosti
eksponenta broja 10 (jer log služi za izračun tog eksponenta). Ako želite i dalje vidjeti
kolike su vrijednosti x i y na osima, a da pritom ne gubite i predivno svojstvo logaritma,
onda možete koordinate osi prikazati na logaritamskoj skali. Kako to izgleda prikazano
je na slici 2.3.

U astronomiji je uobičajeno koristi logaritamske skale, pa je stoga važno se na njih
naviknuti. Uostalom, jedinica za sjaj je magnituda (vidi iduće poglavlje 2.1.3), koja je u
stvari logaritam sjaja zvijezda ili galaksija. Zato je logaritam sastavni dio fotometrije.

2.1.3 Magnitude

Tijekom gotovo čitave svoje povijesti ljudi su noćno nebo promatrali samo očima. Čak
i kada se pojavio teleskop prije oko 400 godina s Galileovim prvim promatranjima, i
dalje je sve bilo samo s očima. Tek pojavom fotografije u 19. stoljeću promatranja
svemira mogla su se prenijeti na instrumente. Ali do tada astronomija se već temeljila na
sustavu određivanja sjaja zvijezda kroz ono kako to vidi ljudsko oko, tj. mozak. A ljudska
percepcija svjetla je u biti gotovo pa logaritamska.

Stoga je u modernoj astronomiji uveden sustav mjerenja sjaja zvijezda u magnitudama
koje su definirane na način da razlika od jedne magnitude odgovara omjeru sjaja zvijezda
od 1001/5 = 5√100 = 102/5. Drugim riječima, ako zvijezde A i B imaju sjaj FA i FB, a
magnitude mA i mB, tada vrijedi:

FA

FB
=

(
102/5

)mB−mA = 10(mB−mA)/2.5 (2.8)

Ako sada primijenimo logaritam na lijevu i desnu stranu jednadžbe i koristimo pravila iz
jednadžbi 2.7, dobijemo općenito pravilo za magnitude koju moramo zapamtiti:

mA − mB = −2.5 log FA

FB
(2.9)

Iz ove jednadžbe uočavamo dva važna svojstva magnituda:

• ako je zvijezda B 100 puta sjajnija od zvijezde A, onda je razlika njihovih magnituda
mA − mB = 5 (jer je log(1/100) = −2),

• što je zvijezda sjajnija, to je njezina magnituda manja.

Kada mjerimo sjaj mi u stvari mjerimo gustoću toka zračenja (eng. flux density), tj.
koliko energije je prošlo kroz površinu našeg senzora unutar nekog vremena i u nekom
rasponu valnih dužina svjetlosti na koje je senzor osjetljiv. Stoga je mjerna jedinica1

gustoće toka zračenja W/m2. Kada kažemo sjaj zvijezde mislimo na tu veličinu.

Primijetite da kod magnituda imamo slobodu definirati što je to nulta magnituda. Ako
definiramo vrijednost gustoće toka zračenja F0 za koji je magnituda nula, onda govorimo

1Ako nas zanima spektar zvijezde onda nam treba gustoća toka zračenja po valnoj dužini (mjereno
recimo u µm) ili frekvenciji (mjereno u Hz) svjetlosti, pa je mjerna jedinica W/(m2µm) ili W/(m2Hz).
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Slika 2.4: Svjetlost koja se širi iz jedne točke u svim smjerovima prati zakon opadanja gustoće toka
zračenja s kvadratom udaljenosti jer površina kroz koji prolazi ista količina energija raste s kvadratom
udaljenosti. Preuzeto iz https://en.wikipedia.org/wiki/Inverse-square_law.

o prividnoj magnitudi zvijezde kojoj je gustoća toka zračenja F :

m = −2.5 log F

F0
(2.10)

Na žalost, realnost života astronoma je poveća konfuzija oko toga kolika je vrijednost F0.
Svaki instrument ima svoju posebnu osjetljivost na razne valne dužine (boje) svjetlosti.
Stoga su astronomi uveli neke standardne filtere kojima je zadatak da u senzore pro-
puste točno definirani raspon boja kako bi F0 mjeren različitim kamerama i teleskopima
imao istu vrijednost. Usprkos tome, precizna fotometrija zahtjeva da se kameru i filtere
"kalibrira" na standardne zvijezde, tj. da se usporedi poznata magnituda tih zvijezda s
magnitudama koje daje kamera. O filterima pišemo više u poglavlju 2.4. Ako pak smo u
mogućnosti da zbrojimo energiju izračenu po svim valnim dužinama, od UV do radio po-
dručja (iako u praksi najviše dolazi iz nekog uskog raspona valnih dužina, poput vidljivih
boja svjetla), tada to nazivamo bolometrijska magnituda. Ali s time se u ovim početnim
koracima fotometrije nećete susresti.

Kada za zvijezdu kažemo da ima neku magnitudu, bez navođenja detalja o filteru, onda
se vjerojatno misli na tzv. vidljivu magnitudu koja je u stvari mjerena kroz standardni
Johnson V filter (najpopularniji filter koji pokriva zelene nijanse i djelomično žute; vidi
poglavlje 2.4). Recimo, Sunce ima magnitudu -26.8, puni Mjesec ima -12.5, a zvijezda
Sirius -1.5.

Očito da je Sunce puno sjajnija zvijezda na nebu od Sirusa jer nam je i puno bliže.
Ako želimo uspoređivati stvarni sjaj zvijezda pomoću magnituda, onda moramo mjeriti
njihov sjaj na istim udaljenostima. Astronomi su zato uveli koncept apsolutne magnitude
kod koje su sve zvijezde postavljene na udaljenost od 10 pc (parseka2) od nas.

Budući da mi ne možemo putovati po svemiru za dolaziti na te udaljenosti od zvijezda,
koristimo svojstvo svjetlosti da gustoća toka zračenja opada s kvadratom udaljenosti (vidi
sliku 2.4). To znači da za zvijezdu koja ima sjaj F i udaljenost d od nas, a sjaj F10 na
udaljenosti od 10 pc, vrijedi

F

F10
=

(10pc
d

)2
(2.11)

21 parsek (pc) = 3.261598 svjetlosnih godina

https://en.wikipedia.org/wiki/Inverse-square_law
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Slika 2.5: Vruća i hladnija zvijezda osjetno se razlikuju u obliku svoje krivulje količine zračenja po valnim
dužinama. Ako im mjerimo sjaj kroz B i V filter, uočiti ćemo da vruća zvijezda ima sjaj FB > FV dok
hladnija ima FB < FV . Zato je indeks boje (vidi jednadžbu 2.13) vruće zvijezde (B − V ) < 0, a hladnije
zvijezde (B − V ) > 0.

Ako sada logaritmiramo lijevu i desnu stranu jednadžbe, te primijenimo definiciju magni-
tude iz formule 2.10, kao i pravila za logaritme iz jednadžbi 2.7, dobijemo

m − M = 5 log d

10pc (2.12)

gdje je m prividna, a M apsolutna magnituda zvijezde. Vrijednost M nam je sada od
velike važnosti jer je povezana s ukupno izračenom energijom zvijezde na način da se
zvijezde mogu uspoređivati. Drugim riječima, M je čudan način zapisa ukupno izračene
energije zvijezde.

2.1.4 Indeks boje

Čak i ako ne znamo apsolutnu magnitudu zvijezde, možemo nešto zaključiti o njoj samo
iz fotometrije kroz različite filtere. Najpoznatiji takav primjer je usporedba magnituda
izmjerenih kroz Johnson B i V filter (vidi poglavlje 2.4). B filter pokriva uglavnom plavo-
ljubičasti dio spektra, dok V filter propušta uglavnom zeleno-žute boje. Ako izmjerimo B
magnitudu mB i V magnitudu mV za zvijezdu koja ima sjaj FB u području B filtera i FV

u području kojeg pokriva V filter, onda je indeks boje (B − V ) definiran kao

(B − V ) = mB − mV = −2.5 log FB

FV
(2.13)

Na primjeru iz slike 2.5 možemo vidjeti zašto je takav indeks boje povezan s temperaturom
zvijezde. Općenito pravilo je da manji indeks boje znači veću temperaturu.



12 Početni pojmovi

2.1.5 Srednja vrijednost i medijan

Kod fotometrije baratamo s mnoštvom brojeva koji su zapisani kao vrijednosti piksela slike
(vidi poglavlje 2.2 o tome što je to digitalna slika). Stoga se uvijek susrećemo s problemom
kako usrednjiti te vrijednosti. Prvi način je srednja vrijednost (eng. average, mean). Ako
imamo N piksela, gdje je vrijednost n-tog piksela xn, onda je srednja vrijednost definirana
kao

x = x1 + x2 + x3 + ... + xN−2 + xN−1 + xN

N
= 1

N

N∑
n=1

xn (2.14)

Na primjer, ako imamo 7 brojeva x = (2, 6, 10, 10, 11, 13, 32), onda je njihov zbroj 84, a
srednja vrijednost 12.

Drugi način se naziva medijan (eng. median) i koristimo drugačiji pristup. Prvo
brojeve poredamo po veličini, a onda odaberemo broj poredan u sredini kao medijan.
Recimo, u prethodnom primjeru medijan je 10 jer ima 3 vrijednosti manje od ili jednake 10
i 3 veće od ili jednake 10. Ako baratamo s parnim brojem piksela, onda uzimamo sredinu
između dvije vrijednosti pozicionirane u sredini po veličini. Na primjer, ako imamo 8
brojeva x = (2, 6, 10, 10, 11, 13, 32, 40), medijan je (10+11)/2=10.5.

Primijetimo kako se srednja vrijednost i medijan razlikuju. Ta razlika postaje jako
važna u fotometriji kada imamo nerazumno velike vrijednosti u pojedinim pikselima jer
su takvi pikseli pokvareni, tj. ne reagiraju ispravno na podražaj svjetlom (tzv. vrući
pikseli). Srednja vrijednost je jako osjetljiva na takve pojedinačne ekstremne vrijednosti,
dok ih medijan ignorira. Na primjer, uzmimo da jedan od 7 piksela ima jako veliku
vrijednost x = (2, 6, 10, 10, 11, 13, 1019). Zbroj je sada 1071, a srednja vrijednost 153. Za
razliku od toga medijan se nije promijenio - i dalje je 10.

2.2 Što je to digitalna slika

Iako pojam digitalne slike može biti dosta širok, nas zanima onaj najčešći i najjednostavniji
oblik gdje se misli na brojčani prikaz dvodimenzionalne slike na način da se ona podijeli na
mnoštvo malenih elemenata koje zovemo pikseli. Svaki piksel ima svoj položaj po visini
i širini slike, te brojčanu vrijednost koja odgovara intenzitetu svjetla koje dolazi iz tog
sitnog komadića slike. Na slici 2.6 prikazan je primjer kako izgleda zvijezda na digitalnoj
slici.

U stvari, digitalna slika nije ništa drugo nego li velika tablica brojeva. Širinu i visinu
tablice nazivamo rezolucija, i govori nam na koliko smo piksela podijelili sliku. U as-
tronomiji piksel igra važnu ulogu jer predstavlja sitnu površinu neba, te je stoga najmanji
detektor svjetla unutar kamere kojom mjerimo sjaj neba. Digitalna kamera ima senzor
koji se sastoji od mnoštva sitnih detektora svjetla i svaki od tih detektora odgovara jednom
pikselu. Kada se očitaju vrijednosti u svim pikselima dobije se digitalna slika. U upotrebi
su dva tipa takvih senzora: CCD (Charge-Coupled Device) i CMOS (Complementary
Metal Oxide Semiconductors). CMOS je prevladao na tržištu tako da vjerojatno vaša
kamera ima CMOS. Razlike su u načinu kako funkcioniraju njihovi elektronički sklopovi,
ali za naše potrebe fotometrije na ovoj razini te razlike su nebitne.
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Slika 2.6: Astronomska digitalna slika neba (A) sastoji se od piksela, koje možemo zamisliti kao sitne
kvadratiće koji prikupljaju svjetlo iz svog malog komadića neba. Zvijezda prekrivena pikselima (B) je
područje u kojem su pikseli prikupili više svjetla. U memoriji računala pikseli su zapisani kao niz brojeva, po
redcima i stupcima (C). Fotometrija se bavi statistikom tih zapisanih brojeva koji predstavljaju izmjerene
vrijednosti svjetla neba. Stoga sliku zvijezde možemo prikazati i kao 3D graf (D) gdje iz ravnine koju
predstavlja nebo izranjaju vrijednosti piksela. U ovom prikazanom primjeru nebo ima sjaj od oko 2000,
uglavnom zbog svjetlosnog onečišćenja neba i signala kojeg stvara sam senzor bez obzira na nebo. Iz tog
pozadinskog sjaja neba izvire poput planine zvijezda koja ima maksimalnu vrijednost 15303.
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Svjetlo zvijezde dovoljno sjajne da se vidi na slici pada na više od jednog piksela
istovremeno (vidi poglavlje 2.3 o tome zašto zvijezde nisu točka). Zato su zvijezde mali,
ali sjajni "otoci" svjetla na mračnoj pozadini neba (vidi sliku 2.6). Budući da nam je
u fotometriji cilj izmjeriti sjaj zvijezde, baviti ćemo se u stvari sa statistikom brojeva
zapisanih u pikselima koje pokriva zvijezda u usporedbi s pikselima oko zvijezde.

Piksel sam za sebe je detektor koji reagira na svjetlo vrlo širokog raspona boja, od
vidljivih do nevidljivih (UV i infracrveno). Stoga se ispred piksela stavljaju filteri koji
propuštaju samo neki specifični raspon boja. U poglavlju 2.4 opisujemo ulogu tih filtera
u fotometriji. Ako koristite fotoaparat onda vam se slika sprema u memoriju na način da
svaki piksel ima zapisana tri broja. Oni su posljedica posebne vrste filtera kojeg zovemo
Bayerova matrica, postavljenog na sam senzor kamere. O tome možete detaljnije pročitati
u poglavlju 2.4.1. Te tri vrijednosti se na ekranu monitora onda prikazuju kao crvena,
zelena i plava boja. Budući da fotometriju ne možemo raditi s takvim zapisom slike, u
uputama za fotometriju biti će i dio o tome kako sliku s tri broja u pikselima pretvoriti u
tri slike sa samo jednim brojem u pikselima.

2.2.1 Što je to FITS (ili FIT ili FTS) format

Budući da su slike u stvari velika tablica brojeva, postoji razni načini kako tu tablicu
zapisati na disk računala ili memorijsku karticu. Recimo da slika ima 5184 redaka i 3456
stupaca. To je gotovo 18 milijuna piksela (rekli bi da je to kamera od 18 megapixel-
a). Još ako moramo zapisati tri broja po pikselu, to postaje velika količina podataka.
U svakodnevnoj primjeni želi se smanjiti taj zapis (to nazivamo kompresija slike), pa su
izmišljeni razni matematički trikovi kojima se to postiže. Dijelimo ih u dvije skupine:
kompresije koje ne gube ništa od podataka o pikselima (eng. lossless compression) , i
kompresije koje djelomično izmjene vrijednosti nekih piksela i tako degradiraju kvalitetu
slike, ali postižu osjetno manju veličinu zapisa (eng. lossy compression).

Za fotometriju je krucijalno do se ne koriste zapisi slike koji mijenjaju vrijednosti pik-
sela. Stoga ako koristite fotoaparat morate aktivirati spremanje slike u sirovom formatu
(npr., .CR2 za Canon, .NEF za Nikon). Nipošto u .JPG jer se tim formatom gube informa-
cije o točnom sjaju piksela! Fotometriju je uobičajeno raditi u astronomskim programima
koji traže da je vaša slika u FITS formatu (ponekad se naziva i FIT ili FTS), koji se
standardno koristi u astronomiji. Ako imate astro-kameru (specifične kamere predviđene
za astronomiju) onda vam slika može automatski biti spremljena u FITS formatu. Ako
koristite fotoaparat, onda ćete sirovi format kasnije pretvoriti u FITS format (uputa kako
to napraviti nalazi se u poglavlju 3.3).

Naziv FITS dolazi od Flexible Image Transport System i puno je više od običnog
zapisa slike. U biti to je način zapisa znanstvenih podataka koji niti ne moraju biti u
obliku slike. Može sadržavati više slika odjednom ili tablice s više od dvije dimenzije.
Također sadrži tekstualni dio koji se naziva header u kojem se zapisuju razni podaci
relevantni astronomima kod analize tih podataka, poput točnog vremena i lokacije gdje je
slika napravljena, na kakvom teleskopu i koja su optička svojstva teleskopa, kako izgleda
nebeski koordinatni sustav na dijelu neba koji je pokriven tom slikom, itd. Naravno, svi ti
podaci se ne upisuju ako ih vi niste podesili da se upišu, ali ako koristite neku FITS sliku
napravljenu na profesionalnoj opservatoriji, možete očekivati mnoštvo upisanih podataka.
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Slika 2.7: LEGO senzor: Zamislimo da je LEGO pločica senzor koji skuplja svjetlo. Senzor se sastoji od
piksela u kojima se podižu lego kockice kako svjetlo pada na njih (gornja slika). Ali senzor ima sloj kockica
i na mjestima gdje bi trebao biti mrak. To zovemo pozadinskim sjajem i uzrok je ili sama elektronika
senzora ili sjaj neba. Iznad pozadinskog sjaja uzdiže se lego zvijezda od svjetla prikupljenog sa zvijezde.
Ako prerežemo ovu LEGO sliku uzduž horizontalne zelene linije, ugledat ćemo profil sjaja zvijezde (donja
slika). Kada bi maknuli pozadinski sjaja ostao bi samo sjaj zvijezde i njezin oblik se naziva PSF.

2.3 Zašto zvijezde nisu točke (što je to PSF)

Zvijezde se nalaze toliko daleko da je njihova veličina na nebu točka kada ih snimamo
kamerom. To bi značilo da čitava zvijezda može stati u jedan jedini piksel. Ali to se
nikada ne dešava - zvijezde su uvijek neka fleka na slici (vidi sliku 2.7). Tome ime više
razloga.

Glavni izvor mrljanja točke je naša atmosfera. Svjetlo zvijezde prolazi kroz mnoštvo
slojeva različitih temperatura i gustoća. U atmosferi uvijek ima gibanja zraka, nekad jača
nekad slabija. To zovemo turbulencija i dešava se čak i kod najmirnijeg i najljepšeg neba
za promatranje. I kao što voda zakrene smjer svjetlosne zrake, tako i atmosfera mijenja
smjer putanje svjetla, iako puno manje nego voda. Jačina tog efekta mijenjanja smjera
ovisi o temperaturi i gustoći zraka, a turbulencija neprestano mijenja te vrijednosti na
raznim mjestima po putanji svjetla koje nam dolazi od zvijezde. Tu pojavu ste sigurno
vidjeli iznad vrućeg asfalta ljeti, kada prizor uz samu površinu migolji zbog gibanja vrućeg
zraka. Konačni rezultat nama na tlu je zvijezda kao mrlja koja titra u sjaju i neprestano se
deformira. Taj efekt zovemo seeing i glavni je limitirajući faktor teleskopima u razlučivosti
sitnih detalja na nebu.

Uz to atmosfera i raspršuje svjetlo, što pojačava mrljanje slike. To je izrazito vidljivo
kada u zraku ima puno vlage koja se kondenzira u sumaglicu vrlo sitnih kapljica. Efekt
raspršenja na njima je jači za kraće valne dužine, pa će nam tako mrlja u plavoj boji biti
veća nego u crvenoj. Naravno, efekt se pojačava što je duži put svjetla kroz atmosferu, pa
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Slika 2.8: Svjetlo lasera koje prolazi kroz sitnu rupicu na alu-foliji ne ostavlja na zidu istu takvu malu
točkicu, nego se pretvara u veliku valovitu mrlju. Razlog tome je valna priroda svjetla, gdje možemo
zamisliti da svjetlo iz rupice izlazi kao valovi koji se onda šire. Ovaj fenomen nazivamo difrakcija svjetlosti.
Iako je otvor teleskopa velika rupa, svejedno dolazi do difrakcije, i valovi su onda vrlo sitni, no svejedno
postoje. Zato čak i svemirski teleskopi vide zvijezde kao mrlje.

je zato bitan i kut gledanja u odnosu na zenit (točka točno iznad naše glave). Budući da
atmosfera apsorbira i raspršuje svjetlo, u poglavlju 2.5 opisujemo i kakav to ima utjecaj na
fotometriju jer se time gubi dio svjetla zvijezde. Stoga se velike profesionalne opservatorije
ciljano grade na velikim visinama sa suhom i rjeđom atmosferom kako bi se smanjio efekt
seeinga.

Ako snimate bez praćenja, ili vam teleskop nema dobro uštimano praćenje, zvijezde
će dodatno imati deformaciju u smjeru gibanja neba. Za fotometriju to ne mora biti
problem ako je deformacija malena jer nas samo zanima uključiti svo pristiglo svjetlo u
izračun ukupnog sjaja.

Ali postoji i situacija kada ne želite da vam je slika zvijezde sitna mrlja. Naime, pikseli
u kameri imaju limit koliko najviše svjetla mogu detektirati. Iznad tog limita pokazivati
će uvijek istu vrijednost. To se zove saturacija piksela i upropastit će vam fotometriju jer
nećete znati koliki je točno sjaj zvijezde. Zato ako je zvijezda jako sjajna, radije se slika
malo defokusira, tj. namjerno se senzor pomakne izvan fokusa. Time se sjajna zvijezda
pretvori u veću mrlju i u piksele će padati manje svijetla od dopuštenog maksimuma. O
tome govorimo u poglavlju 4.2 jer će vam se vjerojatno pojaviti kao problem ako snimate
bez praćenja vrtnje neba.

Pomislili bi nakon ovoga da se slanjem teleskopa u svemir rješavamo svih tih problema i
zvijezde će postati točka. No ni tada nam to ne uspijeva zbog valne prirode svjetla. Na slici
2.8 prikazan je eksperiment u kojem laser obasjava vrlo sitnu rupicu. Na zidu se umjesto
male stine točkice vidi velika valovita mrlja s izraženim koncentričnim kružnicama koje
zovemo Airy prstenovi. Razlog tome je što svjetlo iz rupice izlazi kao val koji se onda širi
na putu do zida. Taj efekt se zove difrakcija i dešava se i na teleskopu. Otvor teleskopa je
tada rupa kroz koju ulazi svjetlo kao val. Mrlja koja se tada stvara iz točkastog zvjezdanog
izvora je vrlo mala, ali vidljiva na pikselima kamere. To ima za posljedicu i da se dvije



2.4 Važnost filtera u astronomiji 17

vrlo bliske zvijezde stope u jednu mrlju i ne možemo ih razlučiti kao odvojene objekte.
Time nam difrakcija stvara i teorijski limit na razlučivost teleskopa bez obzira na to koliko
kvalitetnu kameru visoke rezolucije imali.

Svi ti procesi kojima se točka pretvara u mrlju mogu se zapisati kao jedna matematička
operacija koja točku pomnoži s oblikom mrlje. Da bi mogli to napraviti potrebna nam je
funkcija, tj. izgled tog geometrijskog oblika, kojom opisujemo deformaciju slike. Naziv za
taj oblik je point spread function, ili skraćeno PSF. U praksi se pronalazi tako da se izmjeri
oblik niza zvijezda različitog sjaja na slici i pronađe matematička formula koja najbolje
opisuje izmjerene oblike. PSF nam može biti jako koristan kada želimo fotometrirati
dvije zvijezde čije se mrlje preklapaju, jer možemo svakoj od zvijezda pridružiti PSF, tj.
geometrijski oblik, i tako izračunati koliki udio u ukupnom izmjerenom sjaju pripada kojoj
zvijezdi.

2.4 Važnost filtera u astronomiji

Budući da je svrha mjerenja sjaja zvijezda povezivanje tih podataka s fizikalnim procesima
koji se odvijaju na i oko zvijezde, vrlo je važno znati koji to točno dio spektra (tj. duge
koju bi stvorilo svjetlo sa zvijezde) mjerimo pomoću naših slika. Boje spektra se filtriraju
na dva načina.

Svjetlo prvo prolazi kroz filter. Kod fotoaparata to je Bayerova matrica koja se sastoji
od tri filtera postavljenih na same piksele čipa kamere, poznatih kako crveni (R), zeleni
(G) i plavi (B). Kod astronomskih kamera koristimo filtere kao dodatak kameri kako bi
ograničili raspon boja koje snimamo kamerom. Moguće je snimati i bez filtera, ali to
pokušajmo izbjeći jer nam korištenje filtera daje znanstveno vrijednije rezultate.

Drugi odabir boja dolazi od same osjetljivosti čipa, tj. senzora. Detekcija se odvija
tako da svjetlo pobuđuje elektrone u pojedinim pikselima čipa. Ali taj proces funkcionira
samo za neki raspon boja, ovisno o materijalu od kojeg je čip načinjen. Profesionalni
astronomi koriste filtere i senzore kojima su pažljivo izmjerili propusnost i osjetljivost.
Mi to nemamo, osim ako prilikom kupnje opreme nismo dobili i te podatke. Ali možemo
fotometrijom posebnih, tzv. standardnih zvijezda izmjeriti u kakvom su odnosu magnitude
dobivene našom opremom s poznatim magnitudama standardnih zvijezda.

2.4.1 Bayerova matrica

Jeste li se zapitali kako ekran vašeg mobitela ili televizora uspijeva prikazati sve moguće
dugine boje? Radi se o iluziji, tj. triku gdje monitor tri zapisane vrijednosti digitalne
slike prikazuje u tzv. RGB sustavu: crvena (R), zelena (G) i plava (B). Mozak pogrešno
interpretira RGB kombinaciju kao boju koja u stvari na monitoru na postoji. Recimo,
kombinaciju zelene i crvene na ekranu mozak pogrešno smatra žutom bojom. Stoga je
žuta boja na ekranu iluzija, za razliku od žute boje u dugi na nebu koja stvarno postoji.
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Slika 2.9: Lijevo: Skica Bayerove RGB matrice postavljene na piksele senzora. Desno: Postupak de-
mozaika gdje se iz tri slike različitih boja spajaju u jednu sliku gdje svaki piksel ima tri vrijednosti (RGB).
Preuzeto iz http://dias.library.tuc.gr/view/manf/25161 (Savvas Tsengelidis, Diploma Thesis, Tech-
nical University of Crete, 2006).

Slika 2.10: Primjeri kako izgledaju slike prije i nakon demozaika Bayerove matrice. Lijevo: Kombini-
ranjem crvene, zelene i plave slike dobivamo sliku u rasponu svih boja. Desno: Na sirovoj slici zvijezda
fotoaparatom vide se razlike između piksela zbog Bayerove matrice. Postupkom demozaika (vidi poglavlje
3.3) stvara se RGB slika u boji.

http://dias.library.tuc.gr/view/manf/25161
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Senzoru u vašem fotoaparatu je omogućeno da "vidi" crvenu, zelenu i plavu boju zah-
valjujući filteru kojeg je još 1976. godine razvio Bryce Bayer iz tvrtke Kodak. Taj mozaik
filter nazivamo Bayerova matrica, a može se označavati i sa oznakom CFA (Color Filter
Array). Nalazi se iznad senzora fotoaparata i pokriva senzor na način da svakom pikselu
pripada jedna od RGB boja (vidi sliku 2.9 lijevo). Može biti raspoređena u različitim
uzorcima, a trenutno se najviše koristi uzorak 2x2 piksela. To znači da je polje od četiri
piksela pokriveno s dva zelena filtera, jednim crvenim i jednim plavim. Zeleni filteri su
dvostruko zastupljeniji jer je ljudsko oko najosjetljivije na zelenu boju, što pridonosi boljoj
reprodukciji detalja i oštrine na slikama.

Kada svjetlost uđe u objektiv kamere3, na putu do senzora ona prolazi kroz Bayerovu
matricu, koja filtrira svjetlost prema bojama, odnosno prema valnim dužinama koje odgo-
varaju svakom filteru. Svaki piksel senzora registrira svjetlost koja je prošla kroz određeni
filter – crveni, zeleni ili plavi. Budući da nijedan piksel samostalno ne može "vidjeti" cijelu
sliku, potrebno je kombinirati podatke kako bi se stvorila potpuna slika u boji (vidi sliku
2.9 desno). Taj proces nazivamo demozaik i koristi sofisticirane algoritme za rekonstruk-
ciju cjelovite slike na temelju intenziteta svjetlosti koje je svaki piksel skupio. Uz naziv
demozaik koriste se i nazivi debayer i CFA interpolacija.

Na taj način smo rekonstruirali sliku i kod jednoličnih površina to je uglavnom pre-
cizno (vidi sliku 2.10 lijevo), no ukoliko na slici imamo oštrih prelaza (poput zvijezda na
crnoj pozadini noćnog neba - vidi sliku 2.10 desno) tu dolazi do gubitka detalja i oštrine.
Uz to, u uvjetima slabog osvjetljenja može pojačati šum, osobito u tamnijim dijelovima
slike. Takav gubitak detalja kod fotografiranja za obiteljski album u potpunosti je zane-
mariv, no ukoliko digitalni fotoaparat koristimo u znanstvene svrhe onda nam gubitak
detalja značajno može otežati ili čak onemogućiti kvalitetno istraživanje. Zato je većina
znanstvenih instrumenata (poput astronomske kamere) monokromatska (bez Bayerove
matrice), a željeni filter se stavlja ispred kamere tako da cijeli senzor snima kroz isti filter.

3Ako se radi o običnom fotoaparatu vjerojatno ima ubačen i jedan dodatni filter ispred čipa kamere
kojim se smanjuje utjecaj crvene boje i nevidljive infracrvene boje. Pripazite na to ako radite neku
astronomsku analizu propusnosti filtera u fotoaparatu.

Slika 2.11: Propusnost Johnsonovog UBV sistema filtera. Slika preuzeta iz https://en.wikipedia.org/
wiki/UBV_photometric_system.

https://en.wikipedia.org/wiki/UBV_photometric_system
https://en.wikipedia.org/wiki/UBV_photometric_system
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Slika 2.12: Lijevo: Spektralna osjetljivost fotoaparata Canon 60D. Osjetljivost je kombinacija propusnosti
Bayerove matrice (tj. Bayerovih RGB filtera na pikselima senzora) i osjetljivosti samog senzora. Slika
preuzeta iz [8]. Desno: Tipične RGB krivulje osjetljivosti raznih digitalnih fotoaparata (plave, zelene,
i crvene linije) u usporedbi sa standardnim V filterom (crna linija). Slika preuzeta iz [9]. Primjere
osjetljivosti raznih tipova fotoaparata možete potražiti u [10].

2.4.2 Astronomski filteri

Astronomske kamere nemaju ugrađene filtere, nego im je spektralni limit zadan samom
osjetljivošću senzora. To znači veliki raspon boja - čitav vidljiv raspon boja (od oko
380 nm do oko 740 nm), pa do bliskog (oku nevidljivog) infracrvenog (do oko 1 000 nm),
ali i ponešto nevidljivog UV (kraćeg od 380 nm). Ako je cilj detekcija objekata, poput
asteroida, koji mogu imati jako slabi sjaj, onda je korisno imati tako veliki raspon os-
jetljivosti ne bi li se skupilo što više svjetla. Ali ako nas zanimaju svojstva objekata koje
promatramo, onda su nam potrebni filteri kojima selektiramo neki dio spektra.

Filtera ima raznih, što zbog toga što im je svrha izdvojiti različite dijelove spektra
povezanih s neki fizikalnim svojstvima nebeskih objekata, što zbog razlika u materijal-
ima od kojih su napravljeni (nekonzistentnost između različitih proizvođača), što zbog
povijesnih razloga jer se udomaćilo koristiti neki sustav filtera. Tako je najpoznatiji i
najpopularniji Johnson-Morganov (skraćeno samo Johnsonov) UBV sustav filtera koji je
bio prvi standardizirani filter (uveden ranih 1950-ih). Pokriva UV boje kroz U filter,
plavo kroz B, i "vidljiv" dio kroz V (zapravo zeleno-žute boje). Magnituda zvijezda u tom
V filteru je ono što je uobičajeno navoditi kao magnitudu zvijezde (recimo u programu
Stellarium su magnitude zvijezda zapravo V magnitude). Slika 2.11 prikazuje propusnost
UBV filtera po valnim dužinama spektra. Kasnije su dodani i filteri R (crvene boje) i I
(nevidljive infracrvene boje od oko 750 nm do 900 nm ili 1100 nm), ali tu je već konfuzija
jer postoje dvije varijante RI filtera.

U ovom uvodnom opisu nećemo ulaziti dublje u tematiku filtera4, ali spomenimo još
kako izgledaju RGB filteri iz Bayerove matrice na senzorima fotoaparata (vidi prethodno
poglavlje 2.4.1). Slika 2.12 prikazuje propusnost takvih RGB filtera i odmah možete prim-
ijetiti raznolikost krivulja. Problem je u tome da različiti tipovi fotoaparata imaju različita
svojstva sloja Bayerove matrice koji se stavlja na piksele senzora. To znači da fotometrija
na slikama istih zvijezda, ali slikana različitim fotoaparatima, može rezultirati razlikama
u izmjerenim magnitudama. Međutim, zanimljiva je usporedba G filtera sa standardnim
V filterom. Postoji poprilično preklapanje. U prvoj praktičnoj vježbi fotometrije istražu-
jemo upravo to svojstvo sličnosti magnituda kroz G filter fotoaparata i V magnitude iz

4Popis raznih filtera u astronomiji i podaci za njihove krivulje propusnosti: http://svo2.cab.
inta-csic.es/svo/theory/fps3/index.php

http://svo2.cab.inta-csic.es/svo/theory/fps3/index.php
http://svo2.cab.inta-csic.es/svo/theory/fps3/index.php
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Slika 2.13: Primjeri slika dobivenih kamerom Micasense RedEdge koja se sastoji od 5 manjih kamera,
svaka sa svojim zasebnim filterom. Propusnost pojedinih filtera prikazana je na grafikonu u donjem desnom
kutu. Slike u gornjem redu su poredane istim redoslijedom kao i filteri na grafikonu. Donja lijeva slika
prikazuje slovima četiri područja, označena s A, B, C i D, koja su opisana u tekstu poglavlja 2.4.3. Filteri
imaju propusnost centriranu na valne dužine (s lijeva na desno) 475 nm (plavi), 560 nm (zeleni), 668 nm
(crveni), 717 nm (crveni rub nevidljivosti), 840 nm (nevidljivi infracrveni). Izvor podataka za grafikon:
http://www.micasense.com.

literature (vidi poglavlje 5.1).

2.4.3 Povezanost filtera i fizikalnih procesa

Pažljivim biranjem filtera astronomi mogu poput detektiva raspetljati tajne koje skrivaju
svemirski objekti. Razlog leži u tome što interakcije svjetla i tvari ovise o frekvenciji (tj.
energiji), odnosno valnoj dužini, svjetla. Rezultat tih interakcija mi gledamo teleskopom
i mjerimo kamerom, ali pomoću filtera selektiramo različite aspekte tih interakcija. Iz
poznate fizike tih interakcija zatim istražujemo kako naša mjerenja uklopiti u razne moguće
scenarije kojima bi objasnili izmjerene vrijednosti.

Kao primjer pogledajte pojedinačne slike prikazane na slici 2.13. Načinjene su poseb-
nom kamerom za daljinska istraživanja svojstava biljaka u poljoprivredi. Radi se o kameri
koja zapravo ima 5 malih kamera od kojih svaka na sebi ima drugačiji filter. Grafikon
prikazuje koje valne dužine su pokrivene sa svakom pojedinačnom malom kamerom.
Uočite sada kako se ponašaju slijedeća područja na slikama:

• Područje A: nebo. Primijetite da nebo postaje tamnije na slikama kako se povećava
njihova valna dužina. Najsjajnije je u plavom području, zbog čega i doživljavamo
nebo kao plavo. Proces koji stvara ovakvu ovisnost svjetla neba o valnoj dužini je
Rayleighovo raspršenje sunčevog svjetla na molekulama zraka. Isti proces odvija se
i u svemiru kada se svjetlo zvijezda raspršuje na plinu i vrlo sitnoj prašini u prostoru

http://www.micasense.com
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između zvijezda. Primjer toga je plavičasta maglica u koju su uronjene zvijezde u
skupu Plejade.

• Područje B: dim. Dim u svakodnevnom životu su čestice veličine od oko 1 µm.
Svjetlo valnih dužina manjih od veličine prašine biti će vrlo efikasno apsorbirano
i raspršeno. Zbog toga je dim na "plavoj" slici gotovo neproziran. Ako pak je
valna dužina slična ili veća od veličine čestica, efikasnost apsorpcije i raspršenja jako
opada. Stoga je dim na "infracrvenoj" slici gotovo nevidljiv. To je razlog zašto su
infracrvene kamere korisne vatrogascima koji se moraju probiti kroz gusti dim. A
isto to svojstvo astronomi rado koriste u izučavanju svemirske prašine oko zvijezda
ili u međuzvjezdanom prostoru. Slikama kroz različite filtere se tako može odrediti
i veličina svemirske prašine.

• Područje C: vatra. Kada zapalite roštilj, vatra ima temperaturu od oko 1 200-
1 500◦C (oko 1 500-1 800 K). Na tim temperaturama plin u plamenu stvara svjetlo,
ali primijetite jaku ovisnost intenziteta tog svjetla na slikama različitih valnih dužina.
Na "plavoj" slici plamen je nevidljiv jer gotovo da uopće ne emitira svjetlo tih valnih
dužina. S druge strane, na "infracrvenoj" slici plamen ima intenzivan sjaj. To je još
jedan razlog zašto su infracrvene kamere korisne vatrogascima. Zvijezde su puno
toplije od tog plamena, ali svaka temperatura ima svoju ovisnost o bojama svjetla.
Sunce, recimo, ima površinsku temperaturu od oko 5 800 K i sjaji najintenzivnije
u vidljivim bojama, dok Sirius ima temperaturu od oko 10 000 K i najsjajniji je
u nevidljivom ultraljubičastom području boja. U poglavlju 2.1.4 opisali smo kako
fotometrijom u dvije različite boje možemo izračunati tzv. indeks boje, koji je
direktno povezan s temperaturom zvijezde.

• Područje D: trava. Korisnost ovakvih multispektralnih kamera u poljoprivredi leži
u svojstvu klorofila u biljkama da sjaje intenzivno u infracrvenim valnim dužinama
od oko 750-1000 nm. Kada su biljke pod stresom (suša, bolest, itd.) opada im taj
sjaj. Razne molekule i atomi u svemiru također imaju neka svoja specifična područja
valnih dužina na kojima intenzivno emitiraju ili apsorbiraju svjetlo. Koristeći filtere
koji propuštaju svjetlo specifično za određene molekule ili atome, astronomi mogu
mapirati njihovu raspodjelu u maglicama i otkrivati što se u maglici dešava.

Ovo je samo dio stvari koje vam se otkrivaju jednom kada uronite u astrofiziku fotometrije.
U ovom priručniku pokušat ćemo vam olakšati prve korake u fotometriju, pa ćemo se stoga
držati jednostavnih primjera i ne ulaziti preduboko u teoriju koja objašnjava pojedine
rezultate fotometrijskih vježbi u poglavlju 5.

2.5 Utjecaj atmosfere na mjerenja sjaja zvijezda

U poglavlju 2.3 opisali smo već probleme koje stvara atmosfera kod fotometrije na način
da deformira sliku zvijezde. Ta vrsta problema stvara oscilacije u izmjerenoj magnitudi,
tj. sjaj zvijezde "titra" zbog turbulencija u atmosferi. Ali atmosfera uz to i apsorbira i
raspršuje svjetlo koje putuje kroz nju, što znači da sjaj zvijezde koji mjerimo na površini
Zemlje nije isti kao i sjaj koji bi vidjeli iz orbite, tj. izvan atmosfere.

Opadanje sjaja zvijezde zbog apsorpcije i raspršenja svjetla u zemljinoj atmosferi
zovemo atmosferska ekstinkcija i predstavlja težak problem ako želimo precizna mjerenja.
Atmosfera nema svugdje jednaku debljinu, a debljina ovisi i o kutu gledanja (vidi sliku
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Slika 2.14: Atmosfera apsorbira i raspršuje svjetlo koje prolazi kroz nju. Zato nije isto ako promatramo
zvijezdu direktno u zenitu ili pod nekim kutom z od zenita.

z 0◦ 5◦ 10◦ 15◦ 20◦ 25◦ 30◦ 35◦

X(z) 1.00 1.00 1.02 1.04 1.06 1.10 1.16 1.22

z 40◦ 45◦ 50◦ 55◦ 60◦ 65◦ 70◦

X(z) 1.31 1.41 1.56 1.74 2.00 2.37 2.92

Tablica 2.2: Približne vrijednosti debljine atmosfere X za različite kutove zenitne udaljenosti z sukladno
jednadžbi 2.16

2.14). Uz to, gustoća i sastav atmosfere opada s visinom što komplicira izračun njezinog ut-
jecaja na proizvoljni kut gledanja. Nadmorska visina i vremenski uvjeti, posebice količina
vlage u zraku, mogu isto dramatično utjecati na opadanje sjaja zvijezde.

Najlakši način da se ovaj problem zaobiđe je da pronađemo neku standardnu zvijezdu
u neposrednoj blizini naše zvijezde koju mjerimo5. Tada izmjerimo magnitudu standardne
zvijezde i usporedimo s vrijednosti iz literature6. Tu razliku u magnitudi onda primijenimo
i na našu zvijezdu i tako korigiramo utjecaj atmosfere.

Na žalost, odmah uočavamo problem: naša mjerenja moraju koristiti isti sustav filtera
i osjetljivosti kamere kao i mjerenja iz literature. To nije često slučaj, pogotovo ako ste
tek krenuli u fotometriju i koristite samo fotoaparat. Iduće što možete napraviti je da
zabilježite izmjerene magnitude standardnih zvijezda i vaših zvijezda koje proučavate,
te koji je bio njihov položaj na nebu. To je onda koristan podatak ako recimo pratite
varijabilnost zvijezda jer tada samo morate korigirati magnitudu za vrijednost kojom
držite standardnu zvijezdu uvijek istog sjaja. A i netko tko bolje razumije osjetljivost
vašeg fotoaparata može iskoristiti te podatke da napravi potrebnu korekciju.

5Najlakše ih je pronaći pomoću AAVSO Star Plotter: https://apps.aavso.org/vsp/
6Još bolje ako imamo nekoliko zvijezda pa izračunamo srednju vrijednost razlika naših magnituda i

onih iz literature.

https://apps.aavso.org/vsp/
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Slika 2.15: Teoretski primjer promjene prividne magnitude zbog utjecaja atmosferske ekstinkcije po
jednadžbi 2.15. Gornji graf prikazuje ovisnost o zenitnoj udaljenosti, a donji o debljini atmosfere (eng. air
mass) uz aproksimaciju iz jednadžbe 2.16. Ovisnost za B magnitudu je m0=5.0 i k=0.4, a za V magnitudu
m0=4.5 i k=0.2.

Jedino što dalje preostaje je raditi korekciju matematički pomoću formule

m = m0 + k X(z) (2.15)

gdje je m izmjerena magnituda, m0 je magnituda prije ulaska svjetla u atmosferu, k je
koeficijent atmosferske ekstinkcije, a X je debljina zemljine atmosfere (eng. air mass) gdje
je vrijednost X=1 kada gledamo točno u zenit. X očito ovisi o kutu z između zenita i
smjera naše zvijezde kojeg zovemo zenitna udaljenost (vidi sliku 2.14).

Ako smo izmjerili m i znamo vrijednosti k i X(z), tada možemo izračunati korigiranu
magnitudu m0. Ali kako saznati te vrijednosti? Na razini preciznosti fotometrije koju
ciljamo u ovom priručniku možemo koristiti najjednostavniju aproksimaciju

X(z) = 1
cos z

(2.16)

(upoznajte se s funkcijom kosinusa ako planirate koristiti ovu formulu), uz dodatno pravilo
da radimo mjerenja što bliže zenitu, te svakako izbjeći mjerenja niže od 30◦ iznad horizonta
(tj. za z > 60◦). U tablici 2.2 možete vidjeti neke vrijednosti za X(z) koristeći ovu formulu.

Daleko veći problem je koeficijent ekstinkcije k jer on ovisi o trenutnom stanju atmos-
fere i o filteru kojeg koristimo. Efekt atmosfere je izraženiji za kraće valne dužine. Na
primjer, k će biti veći za B filter nego za V filter. Jedini način da odredimo k je da ti-
jekom noći mjerimo magnitudu standardne zvijezde koja će proći blizu zenitu i onda kroz
mjerenja provući pravac sukladno jednadžbi 2.15, gdje će m0 i k biti nepoznati parametri
pravca. Na slici 2.15 prikazan je primjer kako bi takva ovisnost izmjerene prividne mag-
nitude ovisila o zenitnoj udaljenosti i debljini atmosfere.
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2.6 Uvod u teoriju pogreške mjerenja

Ne postoji savršeno točno mjerenje jer mjerenja uvijek dolaze s nekom pogreškom. U
znanosti je iznimno važno komunicirati kolika je ta pogreška mjerenja, ali to nije uvijek
lako odrediti jer izvori pogrešaka su različiti i često skriveni od našeg pogleda. Stoga
je kod zahtjevnijih metoda mjerenja i/ili kompleksnijih mjernih instrumenata potrebno
pravo znanstveno istraživanje ne bi li se razotkrili svi izvori pogrešaka i razvio matematički
opis kojim se te pogreške mogu izračunati u praksi.

Fotometrija je upravo takva disciplina koja je i metodički i instrumentalno zahtjevna
za pravilno tretiranje pogreške mjerenja. To međutim ne znači da nemamo načina kako se
nositi s time na nekom približnom nivou koji je dovoljno dobar za shvatiti koja mjerenja su
pouzdanija od drugih i koliko. Za početak istaknuti ćemo glavno pravilo kojim se morate
voditi:

Čak i odokativna procjena pogreške bolja je od rezultata kojem niste pridružili
nikakvu pogrešku.

Recimo, ako koristite ravnalo iz svoje pernice i izmjerite da je nešto široko 11 mm, kolika
je pogreška mjerenja? Možda ste čuli za savjet da ponavljate mjerenja pa izračunate
srednju vrijednost. Međutim, vama je rezultat svaki puta 11 mm. Je li onda pogreška
0 mm? Naravno da nije. pogreška je u ovom slučaju određena time koliko sitne detalje
možete pouzdano izmjeriti. Odokativno možete procijeniti da vjerojatno ne griješite više
od ±1 mm, jer to je debljina crtice od 1 mm na ravnalu.

2.6.1 Tipovi pogrešaka

Pogreške se može podijeliti u tri skupine po načine kako nastaju:

• Grube pogreške (eng. gross errors): Realnost života je da nam se ponekad desi
propust i poneko mjerenje krivo pročitamo ili krivo zapišemo ili nepažljivo odradimo.
Tako izmjerena vrijednost može se drastično razlikovati od ostalih koje smo napravili.
A možda se i desilo u tom trenutku nešto neočekivano kod tog mjerenja i izbacilo ga
iz redovnih vrijednosti. Recimo, kod fotometrije se može desiti da nam zvijezda sjedi
na pokvarenom pikselu ili je na tom mjestu udarila kozmička zraka u senzor. To je
razlog zašto se kod precizne fotometrije koristi više od jedne slike istog dijela neba,
ako i pažljivo prati ispravnosti svih piksela. Jer ponekad nije do grube pogreške
nego se nešto čudno desilo sa zvijezdom, ali moramo biti u to uvjereni budući da je
praksa grube pogreške maknuti iz daljnje analize.

• Slučajne pogreške (eng. random errors): Uobičajeno je imati potpuno slučajne
i nepredvidljive promjene u eksperimentalnim uvjetima, što dovodi do neprestanih
slučajnih promjena u rezultatima mjerenja. Kod fotometrije znamo da nam atmos-
fera neprestano stvara promjene u sjaju zvijezde, o čemu smo već ranije govorili u
poglavlju 2.3. Ali i u samoj kameri neprestano dolazi do fluktuacija u osjetljivosti,
kao i slučajnih emisija elektrona u pikselima senzora (tzv. termalni elektroni) koji
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se onda pogrešno broje kao doprinos od apsorbiranog svjetla. Ako je neki pro-
ces sasvim slučajan onda ga se može matematički opisati i pretvoriti u procjenu
pogreške. Višestruko ponavljanje mjerenja služi upravo tome da se odredi raspon
takvih slučajnih pogrešaka.

• Sistemske pogreške (eng. systematic errors): Ovaj tip pogrešaka sustavno mijenja
rezultat. Možemo ih lakše razumjeti ako ih podijelimo u podskupine po tome gdje
nastaju:

– Okolišne pogreške: Vanjski okolišni utjecaji mogu stvoriti uvjete u kojima dolazi
do pomaka u mjerenim vrijednostima. Recimo, ako je došlo do osjetne promjene
temperature, a mi smo prikupili podatke za korekciju pozadinskog šuma na
staroj temperaturi. Atmosferska ekstinkcija koju opisujemo u poglavlju 2.5
također je taj tip pogreške.

– Opažačke pogreške: Ponekad se desi da sustavno očitavamo krive vrijednosti.
Recimo, zabunimo se koji filter je u upotrebi kod fotometrije.

– Instrumentalne pogreške: U situacijama kada nam instrument kojim mjerimo
nije ispravan ili ga je potrebno redovito podešavati, pojavljivati će se sustavna
pogreška u očitavanju mjerenja. Recimo kada interni sat u kameri kasni i
vremena na slikama su pogrešna.

Sistemske pogreške su najčešće podmukle i teško dokučive, ali ako ih uspijemo sh-
vatiti tada se često mogu matematički ispraviti.

2.6.2 Izračun pogreške višestrukih mjerenja

Budući da se grube pogreške lako uočavaju, a sistemske teško, u praksi se prvenstveno
fokusiramo na slučajne pogreške. Kako bi procijenili kolika su ta slučajna odstupanja,
uobičajeno je ponavljati mjerenja i izračunati koliki je prosjek i pripadna pogreška.

Recimo da imamo N mjerenja, gdje pojedinačna mjerenja obilježimo kao x1,x2, x3,
..., xN . Najbolju procjenu točne vrijednosti dobijemo tako da uzmemo srednju vrijednost
(vidi također poglavlje 2.1.5 i jednadžbu 2.14)

x = 1
N

N∑
n=1

xn (2.17)

Pritom obratite pažnju ako neka vrijednost mjerenja jako odskače jer možda se radi o
gruboj pogrešci koju je bolje izbaciti iz izračuna (ali ako pišete neki stručni rad ili radnju za
natjecanja, i niste otkrili razlog iza grube pogreške, onda takve grube pogreške spomenite
i navedite zašto smatrate da se radi o grubim pogreškama!).

Pogrešku mjerenja označit ćemo ∆x i ako baratamo s malo mjerenja (recimo manje od
5), onda samo izračunamo najveće odstupanje od srednje vrijednosti7. Ako imamo nešto
više mjerenja, tada pogrešku računamo kao

∆x =

√√√√√√
N∑

n=1
(xn − x)2

N(N − 1) (2.18)

7Na primjer, ako su mjerenja bila 4,5,1,6, onda je x = 4, najveće odstupanje je -3, pa je rezultat 4±3.



2.6 Uvod u teoriju pogreške mjerenja 27

Slika 2.16: Primjer izračuna pogreške mjerenja koristeći Excel. U ovom primjeru radi se o 7 mjerenja.
Naredba AVERAGE računa srednju vrijednost, a STDEV.S je tzv. standardna devijacija (ili standardno
odstupanje) koje je potrebno podijeliti s korijenom broja mjerenja, gdje je SQRT(7)=

√
7. Pripazite na

zaokruživanje decimala: konačni rezultat je 47±2.

To se naziva standardna pogreška aritmetičke sredine8 (eng. standard error on the mean).

Konačni rezultat mjerenja prezentiramo kao x ± ∆x. Kako bi si olakšali ovaj izračun
možete koristiti naredbe u Excelu koje to automatski izračunaju (vidi sliku 2.16).

2.6.3 Izračun pogreške pogrešaka mjerenja

Primijetite da u prethodnom slučaju u poglavlju 2.6.2 pojedinačna mjerenja nisu imala
pridruženu pogrešku mjerenja. A u fotometriji ćete se naći upravo u situaciji gdje svako
mjerenje sjaja zvijezde Fn ima svoju fotometrijsku pogrešku ∆Fn. Ako na taj način
ponavljate mjerenja sjaja zvijezde, i želite sada izračunati prosječni sjaj F i pripadnu
pogrešku, koristite slijedeće jednadžbe:

F =

N∑
n=1

Fn
(∆Fn)2

N∑
n=1

1
(∆Fn)2

∆F = 1√
N∑

n=1
1

(∆Fn)2

(2.19)

Konačni rezultat mjerenja opet prezentiramo kao F ± ∆F , a u idućem poglavlju 2.6.4 je
uputa kako to pretvoriti u magnitudu s pripadnom pogreškom. Ovaj rezultat iz jednadžbi
2.19 naziva se još i težinska ili ponderirana aritmetička sredina (eng. weighted mean).

Za lakše razumijevanje, pogledajmo jedan primjer. Recimo da imamo tri mjerenja
sjaja zvijezde: 100±20, 90±25 i 110±30. Kombinirani ukupni rezultat je:

F =
100
202 + 90

252 + 110
302

1
202 + 1

252 + 1
302

= 99 ∆F = 1√
1

202 + 1
252 + 1

302

= 14

2.6.4 Posredna mjerenja (propagacija pogreške)

Često nas zapravo zanima neka veličina kojoj su mjerenja samo ulazni podatak. Recimo,
kod fotometrije su to magnituda ili pak indeks boje kojima je kao ulaz mjerenje sjaja

8Pritom pogreška svakog pojedinačnog mjerenja xn iznosi
√

N · ∆x.
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piksela na slici. U takvim situacijama pogrešku konačne veličine potrebno je ispravno
propagirati.

Magnituda je definirana kao logaritam izmjerenog sjaja zvijezde (vidi jednadžbu 2.10)
m = −2.5 log F . Ako je sjaj izmjeren kao F = F ± ∆F , tada je jedan način propagiranja
pogreške izračun magnitude za F + ∆F i za F − ∆F u odnosu na srednju magnitudu m:

m = −2.5 log(F )
∆m+ = −2.5 log(F − ∆F ) − m

∆m− = m + 2.5 log(F + ∆F )

m = m +∆m+

−∆m− (2.20)

Ovaj čudan zapis pogreške dolazi od toga što nije nužno zadovoljeno da su ta dva odstu-
panja ∆m+ i ∆m− jednaka. Na primjer, ako je F = 100 i ∆F = 30, onda je m = −5.0,
∆m+ = 0.4 i ∆m− = 0.3, pa rezultat pišemo9 kao m = −5.0+0.4

−0.3.

Kod indeksa boje imamo dodanu komplikaciju jer rezultat ovisi o dva različita mjerenja
magnitude: (B − V ) = mB − mV (vidi jednadžbu 2.13). Ako magnitude imaju svoje
pogreške ∆mB i ∆mV , tada pogreška indeksa boje ∆B−V iznosi

∆B−V =
√

(∆mB)2 + (∆mV )2 (2.21)

Možda ćete naići i na problem propagacije pogreške kod produkta z = x · y ili omjera
z = x/y izmjerenih vrijednosti. Pogreška rezultata je tada

∆z = z ·

√(∆x

x

)2
+

(∆y

y

)2
(2.22)

2.6.5 Fotometrijska pogreška mjerenja sjaja zvijezde

Fotometrija ima kompliciranu strukturu pogreške mjerenja, zbog čega u ovom uvodu ne
možemo ulaziti preduboko u detalje. Isto tako bi za pravilan izračun te pogreške trebalo
izmjeriti i osjetljivost senzora kamere, što nadilazi naš plan uvoda u fotometriju. Analiza
pogreške mjerenja vrlo je važan dio astronomije i često nezaobilazan dio u znanstvenim
radovima Stoga ćemo ovdje primijeniti pojednostavljenu metodu, ali ako vas zanima ući
dublje u problematiku izvora pogreške i kako se s time nositi možete krenuti od [1, 7]. Ako
radite s fotoaparatom posebno se pozabavite problematikom utjecaja ISO vrijednosti [5],
za koju ćete već u prvoj vježbi fotometrije u poglavlju 5.1 vidjeti kako ima velik utjecaj
na rezultat.

Osnovna svih analiza slučajnih pogrešaka mjerenja temelji se na izračunu omjera sig-
nala i šuma (eng. signal-to-noise ratio, S/N). Cilj nam je uvijek postići što veću S/N
vrijednost jer time smo sigurniji u točnost izmjerene vrijednosti signala. Stoga se bavimo
pitanjem što je sve izvor šuma, tj. što sve utječe na pojavu slučajne pogreške. Budući
da fotometrijom prikupljamo svjetlo koje dolazi od nebeskog objekta (zvijezda, galaksija,
itd.), prvi izvor pogreške su slučajnosti u dolasku fotona svjetla do naše kamere. Iako je

9Primjetite pravilo zaokruživanja pogreške jer izračun daje ∆m+ = 0.3872... i ∆m− = 0.2848...
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Slika 2.17: Primjer sjaja piksela kod zvijezda vrlo različitog sjaja. Gornja dva grafa prate vrijednosti
piksela uzduž linije prikazane na donjoj slici. Linija prelazi preko četiri zvijezde, označene A, B, C i D. Na
najgornjem grafikonu vidi se kako su zvijezde B i D puno sjajnije od A i C. Isto tako, na tom grafikonu
sjaj neba izgleda kao ravna crta. Ali na drugom grafikonu je y-os podešena da prikazuje raspon vrijednosti
bliže sjaju neba. Sada se vidi da su A i C osjetno sjajnije od sjaja neba, ali i da nebo nema svugdje isti
sjaj nego je podložno slučajnim varijacijama u mjerenju (područje istaknuto pravokutnikom).

u prosjeku to neki stalni broj fotona u dužoj jedinici vremena, vremenski razmak između
njihovih pojedinačnih dolazaka je slučajan10. Ako izmjerimo da je sa zvijezde stiglo F
fotona, onda je zbog te slučajnosti statistička pogreška

∆F =
√

F (2.23)

Ovdje je važno primijetiti da govorimo o broju fotona, a ne vrijednosti piksela koju ste
očitali na slici u vašem računalu. Da bi pikselu bila pridružena neka brojčana vrijednost,
prvo je određeni broj fotona morao pobuditi elektron u pikselu senzora, a zatim je elek-
tronika kamere morala ukupni broj pobuđenih elektrona pretvoriti u neku brojku koja se
zapisuje u memoriju vaše kamere (ili računala). Kako bi pojednostavili izračun pogreške,
izbjegnut ćemo analizu svih tih koraka i zadovoljiti se aproksimacijom da je F broj koji
očitate iz piksela vaše slike u računalu.

Jednadžba 2.23 nam sugerira važan trend kod analize pogreške. Primijetite da što
je objekt sjajniji, time je F veći, a šum (tj. pogreška) relativno manji (npr. za F=100
je ∆F=10 što je 10% od F , ali za F=1 000 000 je ∆F=1 000 što je samo 0.1% od F ).

10Za one koji žele znati više: matematički se to opisuje Poissonovom raspodjelom.
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Na žalost, u astronomiji se bavimo mjerenjem sićušnih točkica svjetla na nebu i malene
vrijednosti F su nam sastavni dio života.

Drugi važan trend vidljiv je ako sjaj zapišemo kao neki konstantan broj fotona u
sekundi f pomnoženo s vremenom ekspozicije t (vrijeme tijekom kojeg prikupljamo sv-
jetlo): F = f · t. Primijetite da sjaj raste linearno s dužinom ekspozicije (F ∼ t), ali
pogreška raste sporije od toga (∆F ∼

√
t). Zbog toga nam greška opada s dužom ekspozi-

cijom.

Na našu žalost, priča o fotometrijskim pogreškama tu tek počinje. Pogledajte sada
sliku 2.17. Pikseli na slikama neba uvijek osim svjetla svemirskih objekata imaju i pozadin-
ski šum. Znači, čak i na mjestima gdje bi trebala vrijednost piksela biti nula, nikada neće
biti nula. Razlog tome je višestruk: pikseli su izloženi svjetlu neba, poneki elektroni spon-
tano budu pobuđeni bez obzira na upadno svjetlo, a i sama elektronika namjerno pridoda
elektrone prilikom čitanja vrijednosti piksela sa senzora (vidi poglavlje 4.2).

Kako bi si olakšali uvodne korake u fotometriju, prvo ćemo raditi na način da uopće ne
uvodimo korekcije slike kojima bi adresirali sve te probleme u izračunu pogreške. Umjesto
toga, jednostavno ćemo izmjeriti vrijednost sjaja piksela na mjestima gdje nema zvijezda
(kako se to radi opisujemo u poglavlju 4.1, pa će ovi koraci biti jasniji kada krenete raditi
svoju prvu fotometriju). Za to ćemo koristiti n0 piksela, a medijan će im biti F0 (koristimo
medijan jer mu se vrijednost ne mijenja ako poneki pikseli imaju nerealno velike vrijednosti
zbog kvara piksela ili nekog neplaniranog izvora svjetla). Zvijezda pak pokriva površinu
od n⋆ piksela koji zbrojeno daju vrijednost F .

Izmjereni sjaj zvijezde F⋆ u takvoj jednostavnoj fotometriji je

F⋆ = F − n⋆F0 (2.24)

a pripadna pogreška u najjednostavnijoj procjeni je11

∆F⋆ =
√

F⋆ + n⋆

(
1 + π

2 · n⋆

n0

)
(∆F0)2 (2.25)

gdje je ∆F0 standardna devijacija (standardno odstupanje) vrijednosti piksela pozadine, a
(∆F0)2 pripadna varijanca (prosječno srednje kvadratno odstupanje). Za izračun varijance
koristimo piksele pozadine (one iz kojih smo pronašli medijan F0) iz formule

(∆F0)2 =
∑n0

i=1(xi − F )2

n0 − 1 (2.26)

gdje su xi pojedinačne vrijednosti piksela, F je srednja vrijednost piksela pozadine, a∑
je simbol koji označava sumiranje po indeksu i (tj. po svim pikselima). Na sreću,

nećemo morati ručno raditi taj izračun, nego će nam program kojim ćemo raditi mjerenja
automatski izračunati varijancu (∆F0)2. Taj postupak opisan je u poglavlju 4.4.1.

Primijetite da je za smanjenje pogreške preporučljivo koristiti puno više piksela za
određivanje sjaja neba nego li piksela za mjerenje sjaja zvijezde, kako bi dobili n⋆/n0 ≪ 1.
Također, ako je zvijezda jako sjajna onda pogreška teži prijašnjem rješenju ∆F⋆ =

√
F⋆.

11Faktor π/2 se pojavljuje zbog korištenja medijana za sjaj pozadine. Ako se koristi srednja vrijednost,
onda taj faktor nestaje.



2.6 Uvod u teoriju pogreške mjerenja 31

Slika 2.18: Primjer statistike piksela kod određivanje pogreške. Najgornji panel: zvijezda (unutar malog
cijan kruga) izdiže se svojim sjajem iznad okolnih piksela (crvenom strelicom i krugom označeno je gdje se
nalazi ispis vrijednosti (∆F0)2, vidi poglavlje 4.4.1). Srednji panel: grafikon prikazuje vrijednosti piksela
uzduž zelene linije označene na najgornjem panelu. Puna linija s točkama su vrijednosti piksela. Crtkana
linija je medijan pozadine (izračunat iz piksela unutar velikog žutog kruga). Okomita crvena crta pokazuje
odmak za jednu standardnu devijaciju iznad i ispod medijana pozadine. Najdonji panel: histogram (puna
stepeničasta linija) vrijednosti piksela unutar velikog žutog kruga na najgornjoj slici. Glatka linija je
Gaussova (normalna) raspodjela koja statistički opisuje taj histogram. Horizontalna crvena linija pokazuje
odmak za jednu standardnu devijaciju iznad i ispod srednje vrijednosti pozadine (ujedno i širina Gaussove
raspodjele).
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Kako bi intuitivno shvatili o čemu ovdje govorimo, poslužit ćemo se primjerom na slici
2.18. Prikazana su tri panela, gdje najgornji prikazuje sliku zvijezde koju analiziramo.
Zvijezda se ističe kao bijela fleka na inače vrlo šumovitoj pozadini kojom je ispunjen os-
tatak slike. Horizontalna linija koja prolazi kroz zvijezdu nam služi da očitamo vrijednosti
piksela po toj liniji. Srednji panel pokazuje te vrijednosti i vidi se kako se sjaj piksela
zvijezde izdiže iznad vrlo nestabilnog sjaja pozadinskih piksela.

Veliki žuti krug na najgornjem panelu služi za određivanje statistike pozadinskih pik-
sela. Crvena crtkana linija na srednjem panelu je medijan vrijednosti piksela unutar tog
kruga. Ta linija koristi se kao vrijednost sjaja pozadine. Okomita crvena crta prikazana
na početku crtkane linije je iznos jedne standardne devijacije ∆F0 iznad i ispod medijana.
To nam je ujedno i neki prosječan raspon odstupanja od medijana.

Najdonji panel ilustrira što mislimo pod tom tvrdnjom o "prosječnom rasponu odstu-
panja". Ako uzmemo sve piksele unutar žutog kruga na najgornjem panelu i napravimo
histogram njihovih vrijednosti, dobijemo stepeničastu liniju na najdonjem panelu. Vidimo
da se radi o raspodjeli koja ima neku širinu. Ako provučemo optimalnu Gaussovu (nor-
malnu) raspodjelu12 kroz ta mjerenja, tada će standardna devijacija ∆F0 biti širina te
raspodjele. Stoga kada od piksela zvijezde oduzimamo sjaj pozadine, moramo uzeti u
obzir da nam točan iznos sjaja pozadine nije poznat, nego da ima neku neodređenost koju
opisujemo pomoću varijance (∆F0)2.

Ukoliko pak se upustimo u osnovne korake korekcije slike (vidi poglavlje 4.3), tada
ulazimo i u komponente izvora šuma. Pogreška u tom slučaju postaje

∆F⋆ =
√

F⋆ + n⋆

(
1 + π

2 · n⋆

n0

)
(Fsky + Fdark + (∆FR)2) (2.27)

gdje su Fsky sjaj neba, Fdark sjaj tamnih slika (eng. dark frame, slike sa zatvorenim
otvorom kamere), a (∆FR)2 varijanca šuma uzrokovanog elektronikom kamere prilikom
čitanja slike sa senzora (vidi poglavlje 4.4). S detaljima ovih komponenti šuma baviti ćemo
se u poglavljima o koracima fotometrije, a kako odrediti Fsky, Fdark i (∆FR)2 opisano je
u poglavlju 4.4.2. I tu ćemo sada stati s daljnjim produbljivanjem teme fotometrijskog
šuma.

12https://en.wikipedia.org/wiki/Normal_distribution

https://en.wikipedia.org/wiki/Normal_distribution


Poglavlje 3

Snimanje neba

Iako na Internetu možemo pronaći mnoštvo astronomskih slika neba vrhunske
kvalitete, već obrađene i spremne za fotometriju, ništa ne može zamijeniti
iskustvo vlastitog snimanja neba i učenja kroz praksu na vlastitim greškama.

Astronomsku fotometriju radimo na digitalnim snimkama noćnog neba. Što je snimka
kvalitetnija, to je i fotometrija preciznija. Problemi leže u tome što postoje i razni izvori
neželjenog šuma u signalu. Stoga se, osim tehnike snimanja samog neba, mogu odraditi
i koraci prikupljanja posebnih vrsta slika kojima je za cilj ublažavanje utjecaja šuma na
fotometrijsku pogrešku. Bez obzira na to, prvi koraci u snimanju neba za najjednostavniju
fotometriju nisu teški i samo traže odlučnost da se upustite u ovu avanturu.

3.1 Prvi korak: snimanje fotoaparatom bez teleskopa i bez
praćenja neba

Ukoliko radite s astro-kamerom, možete preskočiti ovo poglavlje i krenuti na fotometriju
vaših FITS slika. Ako pak radite s fotoaparatom evo nekoliko ključnih uputa kako sni-
mati noćno nebo pomoću objektiva na fotoaparatu (preporuka je koristiti objektiv do
maksimalno 135 mm):

1. Ako koristite fotoaparat, poput DSLR kamera, onda morate na njemu aktivirati
spremanje slike u sirovom formatu (npr., .CR2 za Canon, .NEF za Nikon). Nipošto
u .JPG jer se tim formatom gube informacije o točnom sjaju piksela! Taj ćete sirovi
format kasnije pretvoriti u FITS format. Ukoliko vam fotoaparat nudi i opciju
rezolucije, odaberite maksimalan broj piksela, tj. maksimalnu veličinu slike.

2. Stavite način rada fotoaparata na ručno podešavanje (oznaka „M“, vidi sliku 3.1).
3. Stavite ISO za početak na 400 do 800. Kasnije možete varirati ISO i promatrati

kako utječe na sliku. Veliki ISO će lako prikazati i sam sjaj neba, ali pritom raste i
šum stvoren u samoj kameri, što može stvoriti problem kod fotometrije. A najveći
problem velikog ISO-a je saturacija vrijednosti piksela sjajnih zvijezda, o čemu više
govorimo u poglavlju 4.2. Konačni ISO biti će rezultat vašeg eksperimentiranja ne
bi li se postigao kompromis između onog što želite vidjeti na slici i količine šuma i
saturacije koje ste voljni tolerirati (vidi sliku 3.2).

4. Ekspozicija ovisi o objektivu kojeg koristite: broj 300 podijelite sa žarišnom duljinom
objektiva i dobili ste maksimalnu vrijednost ekspozicije. Na primjer, objektiv od
50 mm omogućuje ekspozicije do 6 sekundi. Sve duže od toga izazvat će izdužene
zvijezde zbog vrtnje neba. Možete se igrati različitim ekspozicijama i sami se uvjeriti
što je najbolji odabir (vidi sliku 3.2).

5. Maksimalno otvorite blendu na objektivu, tj. postavite F-broj na minimalnu vrijed-
nost (vidi sliku 3.2).

6. Isključite automatski fokus i stabilizaciju slike (vidi sliku 3.3).
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Slika 3.1: Aktiviranje ručnog načina rada, prebacivanjem prekidača na oznaku “M”.

Slika 3.2: Izbornik fotoaparata, gdje se mogu pratiti vrijednosti ekspozicije, blende i ISO vrijednosti.

Slika 3.3: Isključivanje automatskog fokusa i stabilizacije slike ovisi o vrsti objektiva kojeg koristite. Za
isključili automatsko fokusiranje objektiva, prekidač s AF (auto fokus) prebacite na MF (manual fokus).
Kod nekih objektiva oznake mogu biti samo A i M, a M opet znači "manual fokus". Stabilizaciju nemaju
svi objektivi. Ako vaš objektiv ima stabilizaciju, prekidač stavite na OFF.
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Slika 3.4: Za podešavanje fokusa koristite oznake za udaljenost koje se nalaze na objektivu. Prsten za
fokus okrenite na beskonačno (slike lijevo), a zatim ga za vrlo sitan pomak okrenite u suprotnom smjeru
(slike desno). Kod jeftinih objektiva postoji mogućnost da nisu upisane oznake za udaljenost. U tom
slučaju kako bi prsten za fokus postavili na beskonačno, okrenite ga skroz ulijevo.

Slika 3.5: A: Slika nije u fokusu i zvijezde su previše razmrljane. B: Fotoaparat se tresao tijekom trajanja
ekspozicije. C: Zvijezde su u fokusu (malo su izdužene jer nema praćenja vrtnje neba). Primijetite „vrući
piksel“ na svim slikama – svijetli piksel koji dolazi zbog greške na kameri i predstavlja neželjeni šum kojeg
se treba paziti kod fotometrije.
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7. Podesite prsten objektiva za fokus na beskonačnost, i zatim ga za vrlo sitan pomak
okrenite u suprotnom smjeru (vidi sliku 3.4).

8. U praksi vjerojatno vam zvijezde neće biti odmah u fokusu. Stoga na prvim probnim
fotografijama pogledajte možete li laganim pomacima prstena fokusa dobiti da vam
zvijezde budu još sitnije (manjeg promjera) na slici (vidi sliku 3.5).

9. Zanimljivo je da će vam za precizniju fotometriju trebati u stvari lagano defokusir-
ana slika. Time se možete baviti kada savladate osnove fotometrije, a više o tome
govorimo u poglavljima 4.2 i 5.4.

Isprobavanje raznih kombinacija ISO vrijednosti i dužine ekspozicije je krucijalno za
postizanje kvalitetne slike. Ako radite sa sjajnijim zvijezdama, trebati će vam i defokus
(obratite pažnju na poglavlje 4.2) tako da zvijezda ima promjer od 8-10 piksela. Ako
želite precizniju fotometriju, onda napravite nekoliko uzastopnih snimaka zvijezde i zatim
usrednjite rezultate fotometrije. Stoga samo strpljivo i pažljivo, a najbolji uvod je da
isprobate primjere u poglavlju 5. Vremenom ćete skupiti iskustva kako podesiti vašu
kameru na optimalan način.

3.2 Prvi korak: snimanje fotoaparatom kroz teleskop

Ako koristite fotoaparat na teleskopu, uvjet je da imate i uključeno praćenje, te koristite
slijedeće korake:

1. Stavite način rada fotoaparata na ručno podešavanje (oznaka „M“, vidi sliku 3.1).
2. Stavite ISO za početak na 400 do 800, i pratite upute kao i za objektiv (poglavlje

3.1).
3. Ekspozicija sada nema ograničenja zbog vrtnje neba. Ograničeni smo samo pozadin-

skim sjajem neba koji na slici postaje sve sjajniji kako ekspozicija raste.
4. Fokusiranje je identično kao kod objektiva (točka 8 u poglavlju 3.1), jedino što sada

nemate prsten fokusa na objektivu nego koristite fokuser na teleskopu.

I ovdje će vam izazov biti ISO, dužina ekspozicije i defokus. Ali zbog praćenja možete
probati se približiti cilju da vam je ISO što manji (ISO100), ekspozicija barem 15 sekundi,
i defokus takav da zvijezda pokrije barem 8-10 piksela kako bi demozaik (debayer) proces
bio uspješan (vidi poglavlje 4.2). Isto tako, preporučljivo je radi postizanja preciznije fo-
tometrije napraviti nekoliko uzastopnih snimaka zvijezde tako da je malčice na drugačijem
mjestu na svakoj slici, i onda usrednjiti rezultate fotometrije.

3.3 Konverzija RGB slike u FITS format

Ako koristite astronomsku kameru onda ovaj korak možete preskočiti jer će vam slika
biti automatski pohranjena u FITS formatu. Ali fotoaparatom ste dobili slike u nekom
njihovom sirovom formatu (npr., .CR2 za Canon, .NEF za Nikon), dok nama treba FITS
format. Stoga treba napraviti konverziju iz sirovog u FITS format. Dodatni problem
je što fotoaparat sadrži crvene, zelene i plave piksele (vidi poglavlje 2.4.1). To znači
da sada kod konverzije u FITS format trebamo stvoriti tri FITS slike, za svaku boju
zasebno, koristeći neki demozaik algoritam (vidi sliku 2.9). To se može napraviti raznim
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aplikacijama (oprez: morate biti sigurni da vam aplikacija nije „pametna“ pa je automatski
poremetila vrijednosti piksela da slika bude ljepša).

Ovdje dajemo primjer kako to napraviti u besplatnoj aplikaciji ASTAP na najjednos-
tavniji način, dok u poglavlju 4.3.2 opisujemo kako konvertirati pomoću aplikacije IRIS,
a u poglavlju 5.5.1 kako pristupiti sirovim pikselima u Python-u. Nakon što savladate
početne korake u fotometriji koristeći ASTAP, IRIS će biti bolji izbor za konverziju. U
poglavlju 5.5 se zato bavimo i opisom kako se rezultat može razlikovati ovisno o metodi
konverzije u FITS.

3.3.1 Konverzija pomoću aplikacije ASTAP

Ako ćete za fotometriju koristiti program SAOImageDS9 (vidi poglavlje 4.1.1), onda je
ovo zgodan način kreiranja FITS slike koja će u sebi imati razdvojene RGB kanale, što
će program DS9 prepoznati. U tu svrhu instalirajte besplatni program ASTAP: http:
//www.hnsky.org/astap (mi smo ovdje koristili verziju 2024.05.24). Koraci u programu
su:

• Učitajte svoju sirovu sliku u program.
• Odaberite Tools→De-mosaic Bayer matrix.
• Zatim odaberite File→Save as FITS file.

Kreirana FITS slika imati će u sebi zapisanu svaku boju zasebno, što ćete primijetiti tek
kada krenete u analizu te FITS slike. Budući da demozaik konverzija neće nužno biti
zadovoljavajuće precizna, preporučljivo je napraviti nekoliko uzastopnih snimaka zvijezde
tako da je malčice na drugačijem mjestu na svakoj slici. Isto tako je za demozaik bolje
imati malo defokusiranu zvijezdu, da pokrije 8-10 piksela. Konačni rezultat je usrednjena
vrijednost izmjerenog sjaja iz pojedinih slika.

3.4 Upotreba astronomskih filtera

Filteri su izuzetno važan alat u astronomiji. Oni omogućuju izoliranje specifičnih valnih
dužina svjetlosti, te time otkrivaju detalje koji bi inače bili izgubljeni u šumu neželjenog
svjetla. Profesionalni astronomi koriste izuzetno široku paletu filtera kako bi mjeren-
jima otkrili astrofizička svojstva nekog objekata, dok astronomi amateri filtere koriste kod
vizualnog promatranja ili snimanja nebeskih objekata. U poglavlju 2.4 opisali smo koja je
važnost filtera u astronomiji, kako su već ugrađeni u fotoaparate, i kako mjerenja pomoću
filtera povezujemo s fizikalnim procesima u Svemiru.

Ovdje ćemo se osvrnuti na neke praktične elemente korištenja filtera u amaterskoj as-
tronomiji, posebice ako ciljate na astrofotografiju, ali su vam upotrebljivi i ako želite raditi
fotometriju. Glavni ciljevi kod korištenja filtera biti će vam smanjiti utjecaj svjetlosnog
onečišćenja, poboljšati odnos signala i šuma, postići što veći kontrast i oštrinu, te što više
naglasiti strukture na objektima koji se promatraju ili snimaju. Filteri dolaze u različitim
veličinama, od 1.25” (31,7 mm) do 2” (50,8 mm), ili kao "unmounted" filteri (samo staklo
bez okvira) za profesionalne kamere. Pojednostavljeno, filtere možemo svrstati u dvije

http://www.hnsky.org/astap
http://www.hnsky.org/astap
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Slika 3.6: Kotač sa filterima za astronomsku kameru (foto:Jasmin Dolamić)

kategorije. Prva su planetarni ili kolor filteri. Ovo je apsorpcijski tip filtera što znači da
blokiraju svjetlo tako da ga apsorbiraju. Proizvođači u ponudi imaju cijeli niz boja, a
ovisno o boji, ovi filteri ističu specifične značajke na planetima. Drugi tip su refleksijski,
a kao što ime sugerira, blokiraju svjetlo tako što reflektiraju neželjenu valnu dužinu. U tu
kategoriju ulaze filteri za astrofotografiju, te za vizualno promatranje objekata dubokog
svemira. Refleksijski se filteri mogu dodatno podijeliti u podkategorije:

• Filteri za smanjenje svjetlosnog onečišćenja: Radi se o filterima dizajniranim za
blokiranje specifičnih valnih dužina svjetlosti koje emitiraju umjetni izvori svjet-
losti, poput natrijevih i živinih lampi. Ovakvih je lampi sve manje jer ih mijenjaju
LED lampe. Nažalost LED emitira u jako širokom spektru, pa ga je teže filtrirati.
Popularni primjeri su UHC (Ultra High Contrast) i CLS (City Light Suppression)
filteri.

• Širokopojasni filteri (RGB i LRGB): Ovi su filteri neizostavan dio svake monokro-
matske kamere. Svaki filter propušta spektar u određenoj valnoj dužini, a omogućuju
stvaranje kolor fotografija kombinacijom crvene, zelene i plave svjetlosti.

• Uskopojasni filteri: NB (narrow band) filteri propuštaju samo vrlo uski raspon valnih
dužina svjetlosti, što je idealno za snimanje emisijskih maglica i analizu kemijskog
sastava objekta kojeg snimamo. Tipični predstavnici uskopojasnih filtera su H-alfa
(Hα) koji propušta svjetlost vodika na 656.3 nm, često se koristi za crveno svjetlo
u maglicama. O-III koji detektira dvostruko ionizirani kisik na 495.9 i 500.7 nm,
vidljiv kao plavo-zelena boja u emisijskim maglicama, te S-II sa fokusom na sumpor
na 671.6 nm. Kombinacija ovih filtera koristi se u astrofotografiji za stvaranje tzv.
"Hubble palete".

Od navedenih se filtera za vizualno promatranje koriste filteri za smanjenje svjetlosnog
onečišćenja i O-III filter, na kolor kamerama (fotoaparati ili RGB astro-kamera) koristi se
također neka od opcija UHC ili CLS filtera, dok na monokromatskim kamerama (astro-
kamerama) koristimo širokopojasne i uskopojasne filtere. U teoriji, moguće je i na kolor
kamerama koristiti uskopojasne filtere, no zbog Bayerove matrice koju te kamere koriste
(vidi poglavlje 2.4.1), dolazi do velikog pada osjetljivosti pa se prednosti tih filtera ne
mogu u potpunosti iskoristiti. Zato ako želimo dobiti sliku s boljim kontrastom i s više
detalja moramo koristiti monokromatsku kameru. Nažalost, korištenje takve kamere za-
htijeva višestruke ekspozicije (svaki filter se snima zasebno) što povećava složenost procesa
snimanja i obrade, a i osjetno produžuje vrijeme snimanja.



Poglavlje 4

Fotometrija

Nakon što su napravljene snimke neba kreće astronomsku fotometrija. Os-
novna ideja je izmjeriti koliko svjetla koje dolazi iz svemirskog objekta
je detektirala kamera, a da se pritom oduzmu svi drugi doprinosi koji sa
svemirom nemaju veze.

Da ponovimo, cilj astronomske fotometrije je izmjeriti gustoću toka zračenja (as-
tronomi to na engleskom nazivaju flux density ili jednostavno samo flux), tj. energiju
koja prolazi kroz jedinicu površine u jedinici vremena (W/m2). Drugim riječima, intere-
sira nas koliko je energije prikupio piksel kamere tijekom vremena trajanja prikupljanja
svjetla na senzoru (ekspozicije, tj. „brzine zatvarača“).

Današnji senzori su čipovi koji na svjetlo reagiraju linearno, što znači da duplo više
svjetla znači i duplo veća vrijednost piksela. To vrijedi tako dugo dok pikseli ne saturiraju,
tj. dosegnu najveću svoju vrijednost. Dakle, ako imamo zvijezdu koja nije saturirala
piksele, fotometrija bi se mogla svesti na zbrajanje vrijednosti u pikselima pokrivenim
sjajem zvijezde.

Na žalost, glavni problem u tome je što vrijednosti koje piksel ima ne dolaze samo od
sjaja zvijezde nego i samo nebo (atmosfera) ima svoj sjaj, a i u samom senzoru stvara se
signal nevezan sa svjetlom zvijezde. Te doprinos nazivamo šum i može jako zagorčati naš
fotometrijski život. Dodatna komplikacija su neravnomjernosti u osvjetljavanju površine
čipa, što dolazi zbog same optike objektiva kamere (ili teleskopa), ali i zbog čestica prašine
koje su možda sjele na sam čip (a da ne govorimo i o drugim problemima poput rošenja
leće zbog kondenzacije vlage).

4.1 Jednostavna fotometrija - prvi koraci

Ali ajmo mi polako, prvo samo s najjednostavnijim pristupom. Glavni izvor šuma koji
ne možemo nikako zaobići je sjaj neba. Posebice ako snimate s neke lokacije koja ima
osjetno svjetlosno onečišćenje. Krenut ćemo s metodom koja ne uključuje mnoštvo koraka
za micanje šuma, nego ćemo samo procijeniti sjaj neba i oduzeti ga od sjaja zvijezde.
Time ćemo možda imati grešku mjerenja i po par desetaka posto, ali za početak nam je to
sasvim dovoljno za započeti se baviti fotometrijom. Pritom je dobro se držati upute da se
ne snimaju zvijezde koje su niže od oko 30◦ iznad horizonta, kako bi izbjegli jači utjecaj
atmosfere (jer što je zvijezda niže prema horizontu, to je duži put kroz atmosferu).

U ovom početnom pristupu doprinos šuma mjerimo na najjednostavniji način koristeći
neposrednu okolinu zvijezde i onda ga oduzimamo od izmjerenog sjaja zvijezde. Pritom je
važno da zvijezda koju mjerimo nije saturirana, tj. da ekspozicija nije bila predugačka za
njen sjaj. U tom slučaju vrijednosti piksela dosegnu maksimum koji dozvoljava kamera,
a mi ostajemo bez informacije koliko je stvarno zvijezda sjajna.
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Budući da ne koristimo kalibrirani senzor (kod kojih izmjerene vrijednosti znamo kako
pretvoriti u W/m2), ovakvom fotometrijom možemo samo mjeriti koliko su zvijezde među-
sobno sjajnije jedna od druge u području osjetljivosti vaše kamere (tzv. diferencijalna
fotometrija). Ako prva zvijezda ima sjaj S1 na vašoj slici, a druga sjaj S2, onda možemo
definirati razliku u njihovim magnitudama:

m1 − m2 = −2.5 log S1
S2

. (4.1)

Nama je cilj izmjeriti sjaj S1 i S2 u proizvoljnoj skali (koja se pokrati jer se sjaj S1 dijeli
sa sjajem S2). To je najlakše postići na način da se naprosto zbroje vrijednosti piksela
koje pokriva zvijezda, ali tako da se pritom oduzme vrijednost pozadinskog šuma. U tu
svrhu prikazat ćemo tehniku aperturne fotometrije, gdje se zvijezda i njezina okolina mjere
unutar koncentričnih kružnica (apertura).

Važno je napomenuti da astronomi koriste posebni tip zapisa slika, pod nazivom FITS,
opisan u poglavlju 2.2.1. U poglavlju 3.3 dajemo upute kako sliku dobivenu fotoaparatom
pretvoriti u FITS. Pritom treba imati na umu da će fotoaparat stvorit RGB sliku, koja
prelaskom u FITS se pretvara u tri zasebne slike: crvenu, zelenu i plavu. Pritom su
sve tri zajedno zapisane u jedan FITS dokument s kojim sada radimo. Ako koristite
astrokameru, posebno dizajniranu kameru za astronomiju, onda odmah imate zapis slike
u FITS formatu.

4.1.1 Jednostavna fotometrija u programu SAOImageDS9

Ima raznih astronomskih programa koji omogućuju fotometriju, ali kroz praksu nam se
za sada pokazao program SAOImageDS9 vrlo lagan za korištene kod početnika: https:
//sites.google.com/cfa.harvard.edu/saoimageds9

Postupak u programu DS9 je slijedeći:

1. Učitajte FITS sliku koju ste kreirali: File→Open. Pritom obratite pažnju:
• ako vam slika ili folder u kojem držite vašu sliku ima neko naše slovo (čćđžš),

DS9 će odbijati otvoriti sliku.
• ovisno o tome kako ste kreirali FITS sliku, moguće da je kod konverzije iz

sirovog formata u FITS došlo do izokretanja slike po vertikalnoj osi. Pripazite
na to ako radite usporedbu s položajima zvijezda (npr. u Stellariumu).

2. Ako želite provjeriti podatke o tome kada je slika napravljena, koja je bila dužina
ekspozicije, ISO vrijednost, tip kamere, i slično, kliknite: File→Header. Fotoaparat
je zabilježio te podatke u zaglavlje (eng. header) slike i ti podaci su sačuvani kod
konverzije u FITS.

3. Ako ste koristili fotoaparat, pojaviti će se dodatni prozor pod nazivom Cube. Nemo-
jte ga zatvoriti, vrlo je važan: omogućuje prebacivanje između crvene (1), zelene (2),
i plave (3) slike klikom na Next (vidi sliku 4.1). Ako ga slučajno zatvorite, možete
ga natrag otvoriti pomoću: Frame→Cube.

4. Prvo si trebate odabrati kako obojati sliku kako bi uopće vidjeli što je na njoj. Za to
je potrebno kliknuti scale i onda odaberite nešto iz ponuđenih mogućnosti (log često
dobro funkcionira, a kombinacija z-scale i histogram će vam uvijek pokazati ima li
nečeg na slici). Zgodno je odabrati i ručno podešavanje: Scale→Scale_Parameters.

https://sites.google.com/cfa.harvard.edu/saoimageds9
https://sites.google.com/cfa.harvard.edu/saoimageds9
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Otvorit će vam se prozor u kojem je iscrtan histogram vrijednosti svih piksela na
slici. Preko histograma iscrtane su crvena i zelena linija koje možete uhvatiti mišem i
micati. To su granice za paletu boja. (Dodatno u meniju pod color možete odabrati
i neku lijepu paletu boja, ali preporučamo da zadržite gray.)

5. Pomoću srednje tipke miša možete kontrolirati povećanje slike. Ili kliknite na zoom
pa odaberite neko povećanje.

6. Kada znate koju zvijezdu želite fotometrirati, postavlja se pitanje koliko je ona
zapravo velika na slici. Tamna pozadina može zavarati, što se vidi iz primjera na slici
4.1, gdje su prikazane vrijednosti piksela uzduž (zelene) linije koja presijeca zvijezdu.
Crvenim strelicama su označeni položaji gdje možemo biti sigurni da se sjaj zvijezde
stopio s pozadinom. Imajte to na umu u slijedećim koracima fotometrije.

7. Mjerenja sjaja piksela moguće je jedino ako ste prvo aktivirali: Edit→Region.
8. Sada odaberite krug unutar kojeg ćete zbrojiti sve vrijednosti piksela. U meniju prvo

selektirajte: Region→Shape→Circle. Zatim, kliknite na zvijezdu i razvucite dovoljno
velik krug okolo nje da ste sigurni kako je unutar njega svo svijetlo koje dopire sa
zvijezde (vidi sliku 4.2). Krug se može selektirati klikom miša i onda micati ako
ga niste dovoljno dobro pozicionirali. Ako ga želite obrisati, prvo ga selektirajte, a
onda kliknite: Region→Delete_Selection.

9. Kliknite dva puta na krug, ili odaberite Region→Get_Information. Pojavit će se
prozorčić u kojem pišu koordinate centra kruga i njegov radijus.

10. Na tom prozorčiću odaberite: Analysis→Statistics. Sada se otvara novi prozorčić u
kojem je ispisana statistika piksela unutar kruga. Zapišite si vrijednosti sum (zbroj
vrijednosti svih piksela) i npix (koliko piksela je unutar kruga).

11. Sada nam treba pozadinski sjaj neba. Odaberite: Region→Shape→Annulus. Zatim
kliknite na sliku i razvucite prsten koji se pojavi. Pomaknite te ga na poziciju
sa središtem na zvijezdi1, te mu podesite debljinu i veličinu da prsten bude izvan
područja zvijezde i da, ako je ikako moguće, nema drugih zvijezda unutra prstena
(vidi sliku 4.2).

12. Kliknite dva puta na prsten ili odaberite Region→Get_Information. Pojavit će se
prozorčić u kojem pišu koordinate centra prstena i njegovi radijusi.

13. Na tom prozorčiću odaberite: Analysis→Statistics. Sada se otvara novi prozorčić u
kojem je ispisana statistika piksela unutar prstena. Zapišite si vrijednost median –
to je medijan vrijednost piksela koji su unutra prstena. Zabilježite i broj piksela,
trebat će vam za izračun pogreške. Zabilježite i vrijednost var, trebat će vam kod
izračuna pogreške.

14. Sada imamo sve vrijednosti za izračun sjaja S te zvijezde sukladno jednadžbi 2.24:
S = sum−median∗npix
Izraženo u magnitudama to je: m = −2.5 log(S).

15. Pripadnu pogrešku računajte u ovoj jednostavnoj verziji fotometrije pomoću jed-
nadžbe 2.25, gdje je (∆F0)2 =var.

Ukoliko želite te vrijednosti izmjeriti u svakoj od RGB slika, dovoljno je samo u prozorčiću
„Cube“ klikati „next“ i vrijednosti u svim drugim prozorima će se automatski mijenjati
same. Sada ste spremni koristiti fotometriju za vaše astronomske avanture.

1Kada ovako imate prsten preko prije iscrtanog kruga, neće moći selektirati krug. Taj problem možete
riješiti tako da selektirate prsten i onda ga prebacite „iza“ kruga pomoću: Region→Move_to_Back.
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Slika 4.1: Lijevo: Prozor „Cube“ omogućuje odabir slike u crvenom (1), zelenom (2) ili plavom (3)
području. Desno: Izgled zvijezde može zavarati. Prava veličina zvijezde je područje gdje se sjaj izdiže
iznad pozadinskog sjaja neba.

Slika 4.2: Aperturna fotometrija koristi kružnice za označavanje područja unutar kojeg se analiziraju
vrijednosti piksela. „A“ je disk koji pokriva sve piksele kojima sjaju doprinosi zvijezda, a „B“ je prsten
koji nam služi za određivanje pozadinskog sjaja neba.
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4.2 Problem saturacije zvijezda (upoznajte offset, ISO i gain)

Ovisno o tome koju kameru koristite, i kakav objektiv ili teleskop, prije ili kasnije suočiti
ćete se s problemom saturacije piksela sjajnih zvijezda. To je situacija kada vam kamera
izgubi sposobnost prikazati točne vrijednosti najsjajnijih piksela jer su prikupili previše
elektrona (tj. svjetla).

Ako imate kameru uz praćenje vrtnje neba, tada želite što dužu ekspoziciju ne bi li
pojačali signal iznad šuma (vidi poglavlje 2.6.5), te da izbjegnete efekte seeinga (brza
titranja sjaja zvijezde zbog atmosfere, vidi poglavlje 2.3). Bilo bi dobro da je ekspozicija
barem 15 sekundi, a maksimalno moguće trajanje će vam odrediti sjaj neba i kvaliteta
praćenja. Ako je ta kamera fotoaparat, tada koristite ISO100 (ovdje ćemo objasniti zašto).
Na žalost, ovako dugačke ekspozicije neminovno vode u saturaciju sjajnijih zvijezda.

Ako nemate praćenje neba, nego samo fotoaparat usmjeren prema nebu, tada ne
možete koristiti dugačku ekspoziciju (jer se zvijezde izdužuju na slici), zbog čega će ne-
dostajati prikupljenog svjetla za napraviti fotometriju. Stoga ste prisiljeni podizati ISO
vrijednost na fotoaparatu, ne bi li povećali vrijednosti piksela da uopće nešto vidite.
ISO800 i više tada nisu neuobičajeni, no tako veliki ISO vrlo lako saturira čak i ne jako
sjajne zvijezde (vidi sliku 4.3).

Slika 4.3: Primjer saturirane zvijezde. Snimka je napravljena fotoaparatom bez praćenja i s ekspozicijom
od 4 sekunde, pa je zvijezda izdužena zbog vrtnje neba. Grafikon prikazuje sjaj zvijezde uzduž linije
označene na slikama. Slike su različitih ISO vrijednosti i samo kod ISO100 nije došlo do saturacije. To se
vidi po tome što su profili sjaja u grafikonu svi istog maksimuma kod ISO200, ISO400 i ISO800, a samo
je kod ISO100 maksimum manji. Sjaj piksela na slikama je obojan (Color→color u DS9) stepeničastom
bojom da se lakše uoče promjene u sjaju (vidi sliku 2.7 kao primjer stepeničastih boja vrijednosti sjaja).
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Slika 4.4: Usporedba fokusirane (lijevo) i defokusirane (desno) sjajne zvijezde. Gornji grafovi pokazuju
vrijednosti piksela uzduž linije označene na slikama ispod grafova. Zvijezda na fokusiranoj slici je saturirala,
tj. na najsjajnije piksele je palo više svjetla nego što pikseli mogu prikazati. Ali kada se slika defokusira,
svjetlo se razbaca na više susjednih piksela i zvijezda više nije saturirana.

Izlaz iz te situacije je lagani defokus objektiva ili teleskopa (tj. fokusera na teleskopu).
Prednost defokusiranja je da se svjetlo zvijezde razlije na više piksela pa nije koncentrirano
na mali broj piksela (vidi sliku 4.4). Time se izbjegne velik broj elektrona u pojedinom
pikselu i zvijezda ne saturira. Uz to, ako koristite fotoaparat, proces pretvaranja slike
u RGB kanale (demozaik, vidi poglavlje 2.4.1) je točniji ako zvijezda pokriva veći broj
piksela. Preporučljivo je da zvijezdu "razmažete" na promjer od 8-10 piksela.

Na žalost, defokusiranje vodi i svom problemu, a to je nestanak manje sjajnih zvijezda
kojima se defokusirano svjetlo stopi sa sjajem neba. To nas prislijava onda na duže
ekspozicije (ako imate praćenje) ili veći ISO (ako imate fotoaparat). Zašto se ISO (tj.
gain ako imate astromameru) pojavljuje kao bitan faktor kod fotoaparata ilustrirano je
na slici 4.5. ISO ili gain u biti samo promijeni skalu kojom broj elektrona u pikselima
pretvaramo u vrijednost piksela na digitalnoj slici. Pritom morate znati i da kamere
dodaju i neku konstantnu vrijednost svim pikselima, koju nazivamo offset. Razlog je u
tome što nisu svi pikseli jednako osjetljivi i dodavanjem offset-a se osiguravamo da su u
svim pikselima pozitivne vrijednosti.

No, bez obzira na sve ove finese, prvi koraci u učenju fotometrije mogu se raditi običnim
fotoaparatom bez praćenja i s jednostavnim postavkama. Treba krenuti kroz jednostavne
primjere i tako usvojiti važne osnovne tehnike fotometrije. U tome će vam pomoći vježbe u
poglavlju 5, a među njima je i vježba iz poglavlja 5.4 koja daje praktičan primjer utjecaja
defokusiranja na fotometriju.
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Slika 4.5: Pojednostavljeni opis funkcioniranja ISO skale i offset-a (ako imate fotoaparat), tj. gain-a i
offset-a (ako imate astrokameru). Senzor kamere pretvara svjetlo u elektrone zarobljene unutar piksela.
Gornji graf pokazuje primjer 10 piksela koji su skupili svjetlo zvijezde, ali i jedan elektron šuma koji nema
veze sa zvijezdom (označeno s B). Elektronika kamere pretvara te elektrone u neku brojčanu vrijednost
u digitalnoj slici, a ISO (ili gain) nam služi da podesimo skalu kojom će se napraviti pretvorba. To ne
znači da je senzor osjetljiviji s većim ISO, nego da samo se drugačije brojčano prikazuju iznosi prikupljenih
elektrona. Tri skale, za tri ISO (tj. gain) vrijednosti (ISO1<ISO2<ISO3) prikazane su uz gornji graf. Donja
tri grafa prikazuju vrijednosti piksela na slici. Offset je vrijednost dodana u svaki piksel, pa vrijednost
pozadine bez elektrona nije nula (označeno s A). Problemi nastaju kod veće ISO vrijednosti kada se ne
mogu prikazati najsjajniji pikseli jer digitalna slika ima neku svoju maksimalnu vrijednost. Takvi pikseli su
u saturaciji (označeno sa C) i iz njih ne možemo odrediti koliko je točno palo svjetla u piksele. Primijetite
kako s većim ISO (tj. gain) raste i vrijednost šuma na slici u odnosu na pozadinu.

4.3 Naprednija fotometrija: korekcija nepravilnosti na slici

Znanstvena astronomija je nemoguća ako se dobro ne poznaje ponašanje opreme i sen-
zora kojima se prikupljaju podaci. Stoga je vrlo korisno nakon jednostavnih prvih koraka
u fotometriji krenuti u smjeru prikupljanja kvalitetnijih podataka opremom koju imate.
Osnovni korak u takvoj naprednijoj fotometriji je postupak korigiranja slika ne bi li se
reducirao šum i ispravile nepravilnosti na slici. Nemojte se iznenaditi ako ćete daleko više
vremena provesti u prikupljanju korektivnih slika nego li u promatranju vašeg astronom-
skog cilja na nebu.

U tu svrhu koristiti ćemo program IRIS koji ima ugrađene procedure za takve korekcije.
U svakom koraku trebati će napraviti serijal korektivnih slika. Za početak napraviti ćete
ih samo jednom i koristiti ih i ubuduće. Naprednija fotometrija pak traži da se barem
neke od tih korektivnih slika rade iznova kada i sama opažačka slika neba.
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U ovim uputama slijedimo zapravo priručnik od AAVSO-a [4], koji se temelji na up-
utama za procesiranje astronomskih slika u IRIS-u [2, 3].

4.3.1 Instalacija i podešavanje programa IRIS

Kako bi koristili IRIS, potrebno ga je instalirati s ove adrese: http://www.astrosurf.
com/buil/iris-software.html (mi smo ovdje koristili verziju 5.59). Ako koristite
fotoaparat, primijetite uputu da treba skinuti i datoteku libdcraw.zip koja je
potrebna za prepoznavanje različitih formata slika. Zatim podesite slijedeće:

• IRIS sve svoje operacije izvodi na slikama u unaprijed definiranom folderu. Stoga
si otvorite jedan radni folder u koji ćete prebaciti slike koje ćete obrađivati. Za-
tim pokrenite IRIS i odaberite File→Settings. Otvoriti će se prozorčić u kojem je
postavite File Type=FIT i Working path podesite na radni folder koji ste otvorili u
ovu svrhu (vidi sliku 4.6). Kad ste završili kliknite OK.

4.3.2 Konverzija sirovog formata u FITS pomoću aplikacije IRIS

Ako koristite fotoaparat onda je potrebno IRIS podesiti da zna kako konvertirati vaše
sirove slike u FITS format. Slijedite ove korake:

• Prebacite sirovu sliku koju je potrebno konvertirati u FITS u radni folder kako je
opisano u prethodnom poglavlju 4.3.1.

• Zatim kliknite na ikonu koja je zaokružena na slici 4.6. Tako se otvara prozor za
podešavanje parametara vaše kamere. Prvo odaberite model kamere (moguće da
vaša nije na popisu pa treba odabrati neku najsličniju. Recimo, za naš Canon EOS
60D odabrali smo opciju u kojoj je 50D). Taj korak je važan je se time definira i

Slika 4.6: Podešavanje parametara programa IRIS potrebnih za konverziju fotografskih slika u FITS
format. Lijevi prozor (Settings) otvara se pomoću File→Settings. Desni prozor (Camera settings) otvara
se klikanjem ikone koja je zaokružena na slici.

http://www.astrosurf.com/buil/iris-software.html
http://www.astrosurf.com/buil/iris-software.html
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izgled Bayerove matrice. Zatim još podesite Binning na 1x1, interpolation method
na linear, i provjerite da je isključen white balance. Sve je to označeno na slici 4.6.
Kad ste završili kliknite OK.

• Sada pomoću File→Load otvorite vašu fotografiju (u našem slučaju to je Canonov
.CR2 format slike).

• Zatim spremite sliku u FITS formatu pomoću File→Save, gdje pod Save as type
odaberite FITS Files.

Ovdje opisanom konverzijom koristite demozaik (debayer) metodu koju ste odabrali pod
interpolation method.

4.3.3 Priprema sirovih slika za daljnju obradu

Ukoliko imate astrokameru kojom ste automatski prilikom snimanja dobili FITS slike:

• Prebacite FITS sliku u radni folder od IRIS-a i, ako već nije, promijenite ekstenziju
iz .fits u .fit. Zatim dodajte broj 1 na kraj imena. Ukoliko imate više slika koje želite
istovremeno obraditi, stavite im redne brojeve na kraj imena. Na primjer slika-1.fit,
slika-2.fit, itd.

Ukoliko imate fotoaparat onda vaše sirove slike (npr., .CR2 za Canon, .NEF za Nikon)
treba prvo dekodirati iz sirovog RGB formata u FITS format. Stoga pratite ove korake:

• Ako već niste, podesite parametre vaše kamere kroz prozor za podešavanje kako je

Slika 4.7: Opcija dekodiranja sirovih RGB slika dobivenih fotoaparatom u FITS slike koje će proći
korekcijsko procesiranje. Crvenim krugom označena ja ikonica koja otvara prozor za tekstualni unos
naredbi u IRIS (sve operacije koje izvodi IRIS mogu se napisati i u obliku programske skripte)
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opisano u prethodnom poglavlju 4.3.2.
• Odaberite u IRIS-u opciju Digital photo→Decode RAW files (vidi sliku 4.7). Vjero-

jatno će vam IRIS nestati s ekrana u tom trenutku jer se automatski smanji, pa
ga samo vratite natrag na ekran. Pojaviti će se prozor naziva Decode RAW files za
dekodiranje slika u FITS.

• Selektirajte mišem svoje sirove slike i povucite ih u prozor za dekodiranje.
• U polje Name upišite kako će vam se zvati dekodirana slika (recimo "slika-"). Ako

konvertirate više slika, nazivu će biti pridodani redni brojevi (npr., slika-1.fit, slika-
2.fit, itd.).

• Kliknite na "->CFA" i pričekajte da završi dekodiranje. Kada je gotovo, kliknite na
Done.

Na kraju ovog prvog koraka u radnom folderu IRIS-a biti će .fit slike spremne za daljnju
obradu.

4.3.4 Korekcija na offset (bias frame)

Na slici 4.5 opisali smo osnovni koncept kako offset (ponekad se naziva bias) i ISO na
fotoaparatu (tj. gain na astrokameri) utječu na sliku. U praksi smo suočeni s problemom
da se pikseli na senzoru međusobno malo razlikuju u osjetljivosti na offset. Uz to, proces
očitanja vrijednosti piksela može unijeti dodatni mali, ali mjerljiv šum. Sliku koja izmjeri
offset (bias) i takav šum po pikselima zovemo bias frame i nije teško je napraviti.

Ideja iza korektivnog bias frame-a je da se napravi slika u totalnom mraku s ekspozi-
cijom od nula sekundi. To bi značilo da su jedino offset i šum elektronike vidljivi na slici.
U praksi slijedite ove korake:

• Za svaku kombinaciju offset-a i ISO (gain) treba napraviti zasebni bias frame (ako
imate fotoaparat onda vam je offset fiksiran i trebate samo mijenjati ISO) sukladno
ovim uputama.

Slika 4.8: Prozori u IRIS koji se otvore prilikom raznih koraka obrade slika: A = priprema bias frame-a,
B = priprema dark frame-a, C = priprema flat field-a, D = primjena korekcijskih slika, E = završna
konverzija natrag u RGB sliku ako radimo s fotoaparatom.
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Slika 4.9: Primjer bias frame-ova za dvije različite ISO vrijednosti (ili dvije gain vrijednosti kod astro
kamere). Histogrami pokazuju raspodjelu vrijednosti piksela gdje se jasno vidi kako veći ISO jako poveća
prikaz razlika između piksela.

• Pokrijte, tj. zatvorite, otvor objektiva ili teleskopa i napravite sliku od nula sekundi
ekspozicije (ili s najkraćom dostupnom). Napravite barem desetak takvih slika (ili
još više - veći broj slika rezultirati će kvalitetnijim bias frame-om)

• Sukladno uputama u poglavlju 4.3.3 pripremite te slike za idući korak, tako da slike
budu u .fit formatu i s rednim brojevima (npr. slika-1.fit, slika-2.fit, itd.).

• Kliknite na Digital photo→Make an offset i otvoriti će vam se mali prozorčić kako
je prikazano na slici 4.8.

• Pod Generic name unesite naziv vaših pripremljenih offset slika iz prethodnog koraka
(npr. "slika-"). Pod Number upišite koliko ih ima. Kliknite OK.

• Kada procesiranje završi, bias frame će vam se prikazati na ekranu. Sada kliknite
na File→Save i snimite bias frame (recimo s imenom "master-bias.fit") u radni IRIS
folder.

Na slici 4.9 prikaz je dva bias frame-a koji se razlikuju po ISO (tj. gain) vrijednosti. Jasno
se vidi kao veći ISO povećava širinu distribucije vrijednosti piksela oko offset vrijednosti.
Takvi bias frame-ovi se mogu koristiti duže vremena, iako u stvarnosti iz noći u noć dolazi
do sitnih promjena u svojstvima piksela. Stoga barem svakih nekoliko mjeseci napravite
novi bias frame.

4.3.5 Korekcija na termalni šum (Dark frame)

Elektroni se u pikselima senzora kamere mogu pojaviti spontano, bez izloženosti svjetlu.
Takvi elektroni stvaraju lažni signal kojeg nazivamo termalnim šumom jer taj efekt sluča-
jnih elektrona raste s temperaturom. Stoga astro kamere imaju hlađenje, ne bi li se
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šum smanjio. Termalni šum raste i s dužinom ekspozicije jer što duže čekamo to je veća
vjerojatnost da će se pojaviti slučajni elektron.

Pojava termalnih elektrona slučajan događaj, pa stoga ne možemo precizno takav
šum maknuti, ali mu možemo predvidljivo smanjiti utjecaj na naša mjerenja. Naime, taj
šum je podložan predvidljivoj statistici za pojedini piksel ako je broj termalnih elektrona
velik. Dark frame služi tome da izmjeri kolika je vjerojatnost da se takav šum pojavio na
pikselima kamere.

Budući da je ta statistika osjetljiva na temperaturu, koja pak jako ovisi o okolišnim
uvjetima (grijanje okolnim zrakom i zagrijanom elektronikom unutar kamere), dark frame
bi se u pravilu trebao raditi svaki puta iznova kada i snimanje neba. Međutim, možemo
si malo olakšati posao ako dark frame zanemarimo u slučaju kratkih ekspozicija. Ili ako
koristimo unaprijed pripremljeni dark frame za neku kombinaciju offseta, gain-a (ISO-a), i
temperature senzora (ove parametre kontroliramo kod astro kamera, dok kod fotoaparata
nemamo kontrolu temperature pa je teže)

IRIS program u postupku korekcija slika uvijek traži i dark frame, pa ako ga želimo
zanemariti onda moramo napraviti "lažni" dark frame u kojem neće biti ničeg, samo nule.
Postupak je slijedeći:

Slika 4.10: Primjer dark frame-ova napravljenih fotoaparatom u frižideru (temperatura blizu 0oC) i na
sobnoj temperaturi (oko 25oC). Ekspozicija je 30 sekundi, a ISO400. Na samim slikama okom ne vidimo
razliku, ali kada se naprave histogrami vrijednosti piksela vidi se razlika između hladnog (gornji grafikon) i
toplog (donji grafikon). Slovom A označena su mala odstupanja od nule zbog slučajnih razlika u pikselima
koje bias frame nije eliminirao. B označava termalni šum kojeg ciljamo s dark frame-ovima. C su "vrući"
(problematični) pikseli koji su blizu maksimalne vrijednosti.
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• Otvori neki bias frame u IRIS-u (File→Open). Ta slika nam samo služi da lažni
dark frame ima isti format kao i naše slike.

• Otvorite prozor za pisanje tekstualnih naredbi (vidi na slici 4.7 crvenim krugom
označeno gdje kliknuti).

• Upišite naredbu:
FILL 0
Time smo čitavu sliku napunili nulama.

• Sada kliknite na File→Save i snimite lažni dark frame (recimo s imenom "master-
dark-lazni.fit") u radni IRIS folder.

Taj lažni dark frame možete iskoristiti kada god želite izbjegnuti korekciju na dark frame.
Pravi dark frame izrađuje se od tamnih slika na slijedeći način:

• Prilikom snimanja neba napravite barem deset tamnih slika (po mogućnosti barem
pet prije i barem pet nakon snimki neba) na način da ne mijenjate postavke kamere
(dakle, isti offset, ISO/gain, ekspozicija, temperatura) ali pokrijete, tj. zatvorite,
otvor objektiva ili teleskopa da ne ulazi svjetlo.

• Sukladno uputama u poglavlju 4.3.3 pripremite te tamne slike za idući korak, tako
da slike budu u .fit formatu i s rednim brojevima (npr. slika-1.fit, slika-2.fit, itd.).

• Kliknite na Digital photo→Make a dark i otvoriti će vam se mali prozorčić kako je
prikazano na slici 4.8.

• Pod Generic name unesite naziv vaših pripremljenih tamnih slika iz prethodnog
koraka (npr. "slika-"). Pod Number upišite koliko ih ima. Pod Offset image unesite
naziv bias frame-a kojeg ste pripremili za isti ovakav offset i gain (kod astro kamere)
ili ovakav ISO (kod fotoaparata). Pod Method odaberite median. Kliknite OK.

• Kada procesiranje završi, dark frame će vam se prikazati na ekranu. Sada kliknite
na File→Save i snimite dark frame (recimo s imenom "master-dark.fit") u radni IRIS
folder.

Na slici 4.10 možete vidjeti primjer kako se razlikuje dark frame ohlađenog i toplog fo-
toaparata. S povećanjem temperature podižu se i vrijednosti termalnih piksela. Ali kao
što smo spomenuli, ako su ekspozicije kratke (nekoliko sekundi), termalnog šuma neće biti
puno pa se može koristiti lažni dark frame.

4.3.6 Korekcija na nejednolikosti po površini slike (Flat field)

Ovo je vjerojatno najvažnija korekcija, a bavi se otklanjanjem nepravilnosti u prikupljanju
svjetla po površini senzora. Kada snimamo nebo očekujemo da je nebitno na koji dio
površine senzora pada svjetlo jer su svi pikseli ravnopravni. Ali u praksi to nije tako, iz
više razloga: pikseli su različite osjetljivosti, prašina na senzoru deformira sliku, vinjeting
(tamniji rubovi slike) zbog optičkih svojstava objektiva ili teleskopske optike, itd.

Korekcija na te nepravilnosti ima jednostavnu logiku: ako napravimo sliku koja ime
sve piksele jednako osvjetljene, tada bi razlike u njihovim vrijednostima trebale odražavati
takve nepravilnosti. Tu sliku zovemo flat field. Nakon toga trebamo podijeliti (skalirati)
naše slike s flat field slikom i time ćemo sve piksele dovesti na istu skalu osjetljivosti.

Na žalost, postići jednoliko osvjetljenje čitavog senzora nije jednostavno. Štoviše,
napraviti flat field koji će ujedno imati i jednolikost po čitavom spektru boja je nemoguće



52 Fotometrija

Slika 4.11: Primjer flat field slike. Grafikon prikazuje vrijednosti uzduž linije označene na slici.

postići. U praksi najjednostavnije približno rješenje je slikanje svijetlog neba. Odaberite
trenutak kada je Sunce taman zašlo ali nebo je još uvijek vrlo sjajno i bez zvijezda. Stavite
kratku ekspoziciju, osjetno manje od sekunde (ali dovoljno dugačku da su vrijednosti
piksela velike, a da ne saturiraju) i nizak ISO (gain), te napravite barem desetak snimaka
u zenit. Ako imate fotoaparat, možete se i vrtiti tako da orijentacija slike u zenitu nije
uvijek ista. Zatim slijedite ove korake:

• Sukladno uputama u poglavlju 4.3.3 pripremite slike svijetlog neba za idući korak,
tako da slike budu u .fit formatu i s rednim brojevima (npr. slika-1.fit, slika-2.fit,
itd.).

• Kliknite na Digital photo→Make a flat-field i otvoriti će vam se mali prozorčić kako
je prikazano na slici 4.8.

• Pod Generic name unesite naziv vaših pripremljenih slika svijetlog neba iz prethodnog
koraka (npr. "slika-"). Pod Number upišite koliko ih ima. Pod Offset image unesite
naziv bias frame-a kojeg ste pripremili za isti ovakav offset i gain (kod astro kamere)
ili ovakav ISO (kod fotoaparata). Normalization value je vrijednost koju će flat field
pikseli imati u prosjeku. Unesite neku vrijednost od nekoliko tisuća (npr. 5000).
Kliknite OK.

• (Napomena: Primijetite da ne koristimo korekciju na dark frame jer je ekspozicija
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vrlo kratka. Ako radite flat field s dužim ekspozicijama, morate napraviti i dark
frame korekciju)

• Kada procesiranje završi, otvorite prozor za pisanje tekstualnih naredbi (vidi na slici
4.7 crvenim krugom označeno gdje kliknuti). Upišite naredbu:
GREY_FLAT
To osigurava da je flat field iste skale po sva tri RGB kanala.

• Konačna flat field slika prikazana je na ekranu. Sada kliknite na File→Save i snimite
flat field (recimo s imenom "master-flat.fit") u radni IRIS folder.

Slika 4.11 prikazuje jedan primjer flat field slike gdje je vrlo izražen efekt vinjetinga.

4.3.7 Korigiranje "vrućih" piksela

Neki pikseli su defektni, što znači da ne reagiraju ispravno na svjetlosni podražaj. Zovemo
ih vrući pikseli jer pokazuju velike vrijednosti čak i na dark frame kada nema svjetla. Za
očekivati je da će vremenom broj takvih piksela rasti kako sve više koristimo kameru.
Isto tako, ako podignemo ISO (gain) možemo očekivati da im se broj poveća. IRIS može
napraviti korekciju na način da promjeni vrijednost takvih piksela koristeći susjedne pik-
sele. Ali zato treba prvo napraviti popis "vrućih" piksela.

Ovu korekciju za početak možete preskočiti, ali kada se uigrate u izradi dark frame-ova
možete si pripremiti i nju. Koraci su slijedeći:

• Otvorite u DS9 dark frame koji ste napravili za potrebe korekcije vaših slika. Kliknite
Scale→min max, a zatim na Scale→Scale parameters. Otvoriti će vam se histogram
poput onih prikazanih na slici 4.10.

• Obratite pažnju na vruće piksele označene na slici 4.10. Oni će biti blizu maksimuma.
Na x-osi histograma su vrijednosti piksela. Odaberite neku vrijednost koja je manja
od vrućih piksela, a veća od termalnog šuma. Vrući pikseli biti će svi iznad te
vrijednosti.

• Pokrenite IRIS i učitajte pomoću (File→Open) taj dark frame.
• Otvorite prozor za pisanje tekstualnih naredbi (vidi na slici 4.7 crvenim krugom

označeno gdje kliknuti).
• Upišite naredbu:

FIND_HOT vrucipikseli Nhot
gdje je Nhot broj koji smo odabrali u prošlom koraku, a vrucipikseli je naziv datoteke
u koju će biti zapisane koordinate svih piksela sjajnijih od Nhot. Nalaziti će su u
IRIS-om radnom folderu i možete je otvoriti kao običan tekst.

Ovaj popis vrućih piksela koristiti ćemo kod korekcije astronomske slike neba.

4.3.8 Korekcija astronomske slike za potrebe fotometrije

Konačno smo spremni napraviti korekcije astronomske slike neba kako bi poboljšali pre-
ciznost fotometrije. Pratite slijedeće korake:

• Sukladno uputama u poglavlju 4.3.3 pripremite svoje astronomske slike za idući
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korak tako da slike budu u .fit formatu i s rednim brojevima (npr. slika-1.fit, slika-
2.fit, itd.).

• Kliknite na Digital photo→Preprocessing i otvoriti će vam se mali prozorčić kako je
prikazano na slici 4.8.

• Sada je potrebno ispuniti sadržaj kućica:
– Pod Input generic name unesite naziv vaših pripremljenih astronomskih slika

iz prethodnog koraka (npr. "slika-").
– Pod Number upišite koliko slika imate.
– Pod Output generic name unesite naziv korigiranih slika koje će se kreirati (npr.

"slika-korigirana-").
– Pod Offset unesite naziv bias frame-a kojeg ste pripremili.
– Pod Dark unesite naziv dark frame-a kojeg ste pripremili.
– Pod Flat-field unesite naziv flat field slike koju ste pripremili.
– Ako imate i popis vrućih piksela, unesite naziv datoteke u Cosmetic file (os-

tavite prazno ako nemate).
– Kućica Optimize mora biti isključena (prazna).

Pazite da koristite korekcijske slike koje po vrijednostima za offset, ISO (gain), i
ekspoziciju odgovaraju vašim astronomskim slikama.

Ako imate astro kameru postupak je gotov i za fotometriju koristite slike pod nazivom
kojeg ste naveli u Output generic name. Ako su vam slike napravljene fotoaparatom, onda
ih treba pretvoriti natrag u RGB slike na slijedeći način:

• Kliknite na Digital photo→Sequence CFA conversion i otvoriti će vam se mali pro-
zorčić kako je prikazano na slici 4.8.

• Pod Generic input name unesite naziv korigiranih slika iz prethodnog koraka (npr.
"slika-korigirana-"). Pod Number upišite koliko slika imate. Pod Generic output
name unesite naziv koji će imati korigirane slike konvertirane u RGB format (npr.
"slika-korigirana-rgb-"). Pod Output type odaberite Color. Kliknite OK.

Konačne korigirane slike zapisane u RGB FITS formatu pod nazivom kojeg ste naveli
u Output generic name pronaći ćete u IRIS-ovom radnom folderu. Na njima radite fo-
tometrijska mjerenja.

4.4 Izračun procjene fotometrijske pogreške

U poglavlju 2.6.5 opisali smo formule za procjenu fotometrijske pogreške. Ovdje ćemo
sada opisati kako odrediti vrijednosti koje ulaze u te formule. Predstavili smo dva pris-
tupa: jednostavna procjena kod koje se ne ulazi u detalje izvora fotometrijskog šuma, te
naprednija procjena gdje se šum pozadine rastavlja na nekoliko različitih komponenti.

4.4.1 Jednostavna procjenja pogreške

Jednadžba 2.25 opisuje najjednostavniju procjenu fotometrijske pogreške. Potrebno je
znati sjaj zvijezde (kojeg dobijemo fotometrijom), broj piksela korištenih za izračun sjaja
zvijezde, broj piksela korištenih za izračun sjaja pozadine, i varijancu (∆F0)2.
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Postupak za određivanje tih vrijednosti već je opisan u poglavlju 4.1.1 gdje dajemo
upute za jednostavnu fotometriju u programu SAOImageDS9. Ovdje kopiramo dio tih
uputa (koraci 11-15 u poglavlju 4.1.1), s naglaskom na vrijednosti koje su nam potrebne
iz piksela pozadine. Ovim koracima prethodi mjerenje sjaja zvijezde i medijana pozadine:

• Odaberite: Region→Shape→Annulus. Zatim kliknite na sliku i razvucite prsten koji
se pojavi. Pomaknite te ga na poziciju sa središtem na zvijezdi, te mu podesite
debljinu i veličinu da prsten bude izvan područja zvijezde i da nema drugih zvijezda
unutra prstena (vidi sliku 4.2). Ako nije moguće izbjeći susjedne zvijezde, postavite
prsten negdje sa strane, što bliže, ali da izbjegnete zvijezde.

• Kliknite dva puta na prsten ili odaberite Region→Get_Information. Pojavit će se
prozorčić u kojem pišu koordinate centra prstena i njegovi radijusi.

• Na tom prozorčiću odaberite: Analysis→Statistics. Sada se otvara novi prozorčić u
kojem je ispisana statistika piksela unutar prstena. Za potrebe izračuna pogreške
trebati će nam broj piksela i vrijednost var.

• Pripadnu pogrešku računajte pomoću jednadžbe 2.25, gdje je (∆F0)2 =var.

4.4.2 Naprednija procjenja pogreške

Jednadžba 2.27 za napredniji izračun fotometrijske pogreške podrazumijeva da ste naprav-
ili niz korekcija slike (tzv. preprocesing opisan u poglavlju 4.3.8). Time bi pikseli nebeske
pozadine trebali imati pogrešku stvorenu isključivo sjajem neba (Fsky), slučajnim pobuđen-
jima piksela zbog topline senzora (Fdark), i šumom elektronike prilikom očitanja vrijednosti
piksela sa senzora ((∆FR)2).

Te vrijednosti izmjerite na slijedeći način:

• Fsky se jednostavno izmjeri direktno na slici kao medijan vrijednosti piksela poza-
dine, ista ona vrijednost koju mjerite kada ju trebate oduzeti sjaju piksela zvijezde.

• Fdark je medijan svih piksela na Dark frame. Ako nema bitnog termalnog šuma, taj
medijan će biti nula. U programu SAOImageDS9 postupak je:

– Učitajte Dark frame koji trebate mjeriti.
– Kliknite: Edit→Region.
– U meniju selektirajte: Region→Shape→Box. Zatim mišem razvucite veliki pra-

vokutnik preko čitave slike.
– Kliknite dva puta na pravokutnik, ili odaberite Region→Get_Information. Po-

javit će se prozorčić u kojem pišu koordinate centra pravokutnika i njegove
stranice.

– Na tom prozorčiću odaberite: Analysis→Statistics. Sada se otvara novi pro-
zorčić u kojem je ispisana statistika piksela. Zapišite vrijednost median.

Ako pak koristite IRIS:
– Učitajte Dark frame koji trebate mjeriti.
– Otvorite prozor za pisanje tekstualnih naredbi (vidi na slici 4.7 crvenim krugom

označeno gdje kliknuti). Upišite naredbu: STAT
– Pojavit će se prozorčić sa statističkim podacima o slici. Nama treba vrijednost

Median.
• (∆FR)2 je malo kompliciranije odredit, pa ćemo ovdje opisati jednu laganiju metodu

za približno određivanje te vrijednosti. Temelji se na pretpostavci da varijacije u
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vrijednostima piksela na offset (bias) slikama dolaze zbog šuma kojeg stvara elek-
tronika prilikom čitanja slike. Stoga nam je cilj izmjeriti koliko jaki šum stvaraju
te varijacije. Postupak se svodi na to da oduzmemo dvije offset slike i izračunamo
standardnu devijaciju σ šuma na tako dobivenoj slici. U tu svrhu možemo koristiti
IRIS na slijedeći način:

– Kopirajte dvije offset slike u IRIS-ov radni folder.
– Sukladno uputama u poglavlju 4.3.3 pripremite te slike za idući korak, tako da

slike budu u .fit formatu i s rednim brojevima (npr. bias-1.fit, bias-2.fit).
– Učitajte prvi bias frame (sliku) u IRIS pomoću (File→Open).
– Otvorite prozor za pisanje tekstualnih naredbi (vidi na slici 4.7 crvenim krugom

označeno gdje kliknuti).
– Sada ćemo od te slike oduzeti drugu bias sliku i dodati recimo vrijednost 5000

tako da smo sigurni da neće biti negativnih vrijednosti piksela. Upišite naredbu:
SUB bias-2 5000
Tu je bias-2 naziv druge slike.

– Sada je na ekranu rezultat tog oduzimanja i treba nam standardna devijacija.
Dovoljno je sada upisati naredbu:
STAT
i u prozorčiću koji ispisuje rezultate pojaviti će se statistički podaci o slici.
Nama treba vrijednost Sigma, jer to je σ koju tražimo.

– Vrijednost varijance šuma (∆FR)2 iz jednadžbe 2.27 je:

(∆FR)2 = σ2

2 (4.2)

Bilo bi dobro imati zapravo više od dvije bias slike i onda ovaj postupak ponavljati
s različitim parovima slika. Kao konačni rezultat uzmite najveći (∆FR)2 koji dobi-
jete. Ovo je samo približna metoda određivanja (∆FR)2, ali dovoljno dobra za naše
početne korake u fotometriju.



Poglavlje 5

Primjeri praktičnih projekata

Primjeri projekata koji se mogu raditi koristeći znanja iz ovog priručnika.

Ovisno o razini prakse koju imate s fotometrijom, ovdje su primjeri vježbi koje možete
odraditi. Svaka vježba dolazi sa slikama za preuzimanje s web-stranice ovog priručnika:
.........
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5.1 Prva vježba koristeći najjednostavniju sliku neba

U ovoj vježbi koristiti ćemo najjednostavniju metodu opsianu u poglavlju 4.1. U tu svrhu
napravili smo fotografiju dijela neba gdje se nalazi Andromeda galaksija, bez teleskopa i
bez praćenja, koristeći Canon EOS 60D fotoaparat. Ekspozicija je bila 10 sekundi, a ISO
čak 4000 i 6400, što je stvorilo dosta jaki pozadinski šum na slici. Može se reći da su to
slike niske kvalitete za potrebe fotometrije. Međutim, ova vježba demonstrirati će kao se
mogu dobiti zanimljivi rezultati.

Ciljevi ove vježbe su (za početak si možete pojednostaviti tako da probate odraditi
samo jedan od ovih ciljeva, a kasnije ih onda objediniti):

1. izmjeriti magnitude zvijezda u G boji (tj. G filteru Bayerove matrice; vidi poglavlje
2.4.1),

2. usporediti mjerenja dobivena na slikama različite ISO vrijednosti,
3. usporediti izmjerne vrijednosti s V magnitudom iz literature za te iste zvijezde (stan-

dardni Johnson V filter, najpopularniji filter koji pokriva zelene nijanse i djelomično
žute; vidi poglavlje 2.4.2).

Za treći cilj smo podatke o V magnitudi zvijezda uzimali iz besplatnog programa Stel-
larium: https://stellarium.org. U njemu pronađete isti dio neba kao i vaša slika.
Kada ćete raditi fotometriju neke zvijezde, u Stellariumu kliknete na tu istu zvijezdu i
ispišu vam se podaci o njoj (magnituda i naziv zvijezde su dva podataka koje zabilježite).
Pritom oprez: program DS9, opisan u poglavlju 4.1.1, pomoću kojeg radimo fotometriju,
zrcalno izokreće sliku po vertikalnoj osi u odnosu na ono što ćete gledati na ekranu u
Stellariumu. A možete po imenu zvijezde potražiti njene podatke i preko Interneta, rec-
imo u SIMBAD bazi podataka: http://cdsportal.u-strasbg.fr/. Ako pak se želite
detaljnije posvetiti ovakvim usporedbama vaših mjerenja i vrijednosti magnituda iz liter-
ature, u poglavlju 5.3 možete pronaći vježbu kako da te vrijednosti saznati direktno uz
pomoć DS9, koji vam uz to prikaže i gdje se koja poznata zvijezda nalazi na vašoj slici.

Redosljed koraka u ovoj vježbi je slijedeći:

• Prvo skinite sirove fotografije (format .CR2) s naše web stranice: http://fotometrija.
advega.hr/prirucnik/Primjer1-CR2.zip
Na slici 5.1 možete vidjeti što prikazuje.

• Zatim primjenite upute o konverziji u FITS format iz poglavlja 3.3. Ako vam ne
uspije, skinite FITS verziju slika s naše web stranice: http://fotometrija.advega.
hr/prirucnik/Primjer1-fits.zip

• Onda otvorite FITS sliku u programu DS9, kako je opisano u poglavlju 4.1.1.
• Zadatak je fotometrirati G kanal (odaberite 2 u prozorčiću "Cube" koji vam se

otvori).
• Za treći cilj pokrenite program Stellarium. Pronađite galaksiju Andromeda i zoomi-

rajte na nju. Sada trebate prepoznati koje zvijezde se to vide na našoj slici neba.
Ovaj korak može biti zahtjevan jer DS9 zrcalno izokrene sliku vertikalno.

• Sada krenite u fotometriju sukladno uputama u poglavlju 4.1.1. Ako želite odraditi
i treći cilj vježbe, onda vodite urednu evidenciju (npr. u Excelu) o zvijezdama koje
mjerite: ime zvijezde i magnituda iz Stellariuma (ili nekog drugog izvora), vaša
mjerenja, te vaša mjerenja preračunata u magnitude.

https://stellarium.org
http://cdsportal.u-strasbg.fr/
http://fotometrija.advega.hr/prirucnik/Primjer1-CR2.zip
http://fotometrija.advega.hr/prirucnik/Primjer1-CR2.zip
http://fotometrija.advega.hr/prirucnik/Primjer1-fits.zip
http://fotometrija.advega.hr/prirucnik/Primjer1-fits.zip
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Tablica 5.1: Naša fotometrijska mjerenja zvijezda na slici 5.2 i grafički prikazana na slici 5.3.
.

Stellarium (ili drugi izvori) Mjerenja G kanala slike Mjerenja G kanala slike

Naziv V mag ISO 4000 ISO 6400

zvijezde sum npix median G mag sum npix median G mag

35 And 4.53 9257826 3712 2080 -15.47 9024621 3276 2074 -15.87

32 And 5.33 6384442 2703 2075 -14.72 7140921 2805 2071 -15.31

V428 And 5.1 4321949 1704 2080 -14.73 7548750 2997 2081 -15.29

HIP3604 6.0 5124489 2256 2080 -14.09 5858660 2465 2080 -14.66

HIP3324 7.3 3652983 1703 2078 -12.64 5342372 2468 2081 -13.29

HIP2336 7.45 5044095 2394 2072 -12.31 5003425 2338 2073 -12.99

HIP1575 6.35 4083658 1857 2072 -13.43 6084490 2740 2070 -14.04

HIP2305 7.95 3590333 1697 2076 -12.07 5811642 2737 2074 -12.83

BD+40 103 8.78 2210925 1052 2078 -10.99 5053186 2405 2077 -11.91

20 Cas 4.95 5994995 2512 2072 -14.74 7591642 3005 2073 -15.34

HIP4411 6.5 5516554 2539 2076 -13.48 10024243 4607 2077 -14.15

HIP2553 6.65 5416438 2496 2075 -13.44 6677475 3006 2076 -14.1

HIP2455 6.75 6025158 2791 2074 -13.44 6643455 3002 2073 -14.06

HIP4205 7.15 5834419 2746 2077 -12.79 6062072 2820 2070 -13.38

41 And 5.0 9510056 4251 2070 -14.63 10733141 4612 2073 -15.17

HIP3779 7.55 4091592 1929 2078 -12.3 5293264 2467 2080 -13.02

HIP2851 7.052 6209551 2935 2072 -12.77 5642910 2654 2077 -12.79

HIP2576 6.883 4809085 2230 2074 -13.16 7096890 3270 2074 -13.75

U početku će vam mjerenja ići sporo, ali kada se uigrate postaje bitno lakše. Kao
primjer, za ovu vježbu fotometrirali smo 18 zvijezda. Njihov položaj je prikazan na slici
5.2. Brojčane vrijednosti naših mjerenja su prikazana u tablici 5.1. Primjetite da se radi o
vrlo sjajnim zvijezdama, tako da je fotometrijska pogreška iz poglavlja 2.6.5 malena. No
to ne znači da su to strašno precizna mjerenja, budući da sigurno dolazi do nepažnji kod
određivanja radijusa kruga (aperture) za mjerenje sjaja zvijezde, kao i mogućih napažnji
u određivanju pozadinskog sjaja i slično. Mjerenja bi trebalo ponavljati, i uz to imati više
slika neba s identičnim postavkama kamere kako bi uhvatili moguće promjene u uvjetima
atmosfere ili netočnostima zbog pokvarenih piksela senzora. Naša procjena je da su takve
pogreške na razini ±0.1 magnitude.

Na slici 5.3 prikazan je grafikon s rezultatima mjerenja temeljen na podacima iz tablice
(uočite da su osi grafikona orijentirane od većih vrijednosti prema manjim jer su sjajnije
zvijezde manje magnitude). Možete učiti jako dobro slaganje s V magnitudom iz literature.
Iako je očekivana pogreška mjerenja mala, pojedinačna mjerenja mogu imati puno veći
pogrešku zbog nepažnji u mjerenju ili pokvarnog piksela, što se vidi i na grafikonu kod
jednog mjerenja.

Budući da nam kamera nije kalibrirana, magnitude će imati neki konstantni pomak,
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Slika 5.1: Slika neba pomoću fotoaparata bez teleskopa i bez praćenja. Slika ima jaki šum i zvijezde su
lagano deformirane zbog vrtnje neba. Svjedeno, na ovoj slici primjenjujemo najjednostavniju fotometriju.

koji je u ovom slučaju G=V-19.9 za ISO 4000 sliku i G=V-20.5 za ISO 6400 sliku. Najveća
odstupanja od tog trenda su manja od 0.3 magnitude. Prevedeno u sjaj zvijezde, mjereći
G magnitudu možemo odrediti V magnitudu pomoću našeg fotoaparate s odsutpanjem
manjim od ∼28%. Zapravo, samo dva naša mjerenja imaju odstupanje veće od 20% od
tog trenda, što je predivan rezultat uzevši u obzir da G i V filteri nisu identični, i da uz
to imamo slike niske kvalitete, a izostala je i dodatna obrada za otklanjanje šuma na slici.

Zanimljivo je uočiti što se dešava s povećanjem ISO vrijednosti. Ovo je tema kojoj
ćemo posvetiti posebnu vježbu, a ovo je tek prvi dodir s tim problemom. Naime, s većim
ISO povećet ćemo osjetljivost kamere, te time detektirati i slabije vidljive zvijezde. Među-
tim, time riskiramo i pojačanje šuma što nam može uništiti preciznost fotometrije. Isto
tako, veći ISO nam može sjanije zvijezde gurnuti u saturaciju (maksimalnu vrijednost pik-
sela) zbog čega ih se neće moći fotometrirati. A s druge strane, premale ISO vrijednosti
onemogućit će senzoru da prikazuje male razlike u sjaju, čime se također gubi preciznost
fotometrije.

Stoga je podešavanje ISO vrijednosti stvar prakse i testiranja. U ovoj vježbi imamo
priliku usporediti dvije ISO vrijednosti. Slika 5.5 prikazuje usporedbu sjaja piksela koji
pokrivaju nebo i zvijezde. Zanimljivo je da s povećanjem ISO vrijednosti s 4 000 na 6 400
nije došlo da osjetnog povećanja sjaja neba. To implicira da je glavni izvor sjaja neba
zapravo šum u samom senzoru kamere. To je važan i zanimljiv detalj kojeg moramo
obratiti u zasebnoj vježbi.
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Slika 5.2: Prikaz procesa fotometrije u programu DS9 gdje se vidi koje zvijezde smo uključili u naš
primjer mjerenja. Uočite da je slika zrcalno izokrenuta po vertikalnoj osi.

Slika 5.3: Grafikon usporedbe naših mjerenja (G magnituda po y-osi) i V magnitude iz literature (x-
os). Različiti simboli i boje prikazuju rezultate za sliku od ISO 4000 (kvadratići) i ISO 6400 (kružići).
Primjetite jedno mjerenje sa ISO 6400 slike jako odstupa (označeno strelicom) gdje je sumnja na ili grubu
pogrešku mjerenja ili na problem s pokvarenim pikselom kamere.
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Slika 5.4: Izmjerene G magnitude na slici od ISO 6400 u usporedbi sa slikom od ISO 4000. Mjerenja su
gotovo identična, samo pomaknuta za 0.6 magnituda. Dva mjerenja imaju osjetan odmak od trenda, gdje
se je jedno može tretirati kao problematično i vjerojatno je gruba pogreška mjerenja (vidi također sliku
5.3).

Slika 5.5: Primjer sjaja dviju zvjezda i neba oko njih na slikama snimljenim fotoaparatom s podešenim
različitim ISO vrijednostima. Grafikoni prikazuju vrijednosti piksela uzduž linije prikazane na slikama
ispod. Zanimljivo kako s porastom osjetljivosti kamere (veći ISO broj) zvijezde poprimaju puno veću
vrijednost dok istovremeno nebo samo malo pojača sjaj. To nam govori da je pozadinski šum u ovom
slučaju vjerojatno dominiran termalnim šumom same kamere.
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5.2 Utjecaj veličine aperture na točnost fotometrije

Zadržati ćemo se na najjednostavnijoj metodi fotometrije opsianoj u poglavlju 4.1. Ovaj
puta koristimo fotografiju otvorenih skupova1 NGC 869 i NGC 884 (poznatih kao h i χ Per-
sei) koju smo napravili koristeći fotoapart Canon EOS 1200D s ekspoziicjom od 20 sekundi
i ISO 800, kroz teleskop koji je imao uključeno praćenje neba. Sirova fotografija (format
.CR2) dostupan je na našoj web stranici: http://fotometrija.advega.hr/prirucnik/
Primjer2-CR2.zip. Primjenite upute o konverziji u FITS format iz poglavlja 3.3, a
ako ne uspijete skinite FITS verziju slike: http://fotometrija.advega.hr/prirucnik/
Primjer2-fits.zip

U jednoj od idućih vježbi pozabavit ćemo se analizom zvijezda u tim skupovima, dok
se ovdje fokusiramo na slijedeća pitanja:

1. kako radijus aperture utječe na točnost fotometrije zvijezde,
2. utječe li preciznost mjerenja pozadinskog sjaja neba i na preciznost fotometrije.

Odgovore na ova pitanja tražiti ćemo kroz fotometriju dviju nasumično dabranih zvijezda
na slici, ali odabranih tako da je jedna zvijezda vrlo sjajna (nazovimo je zvijezda A), a

1https://en.wikipedia.org/wiki/Double_Cluster

Slika 5.6: Prikaz apertura u fotometrijskoj analizi zvijezde A (položaj na slici: x=2857, y=2186). Pro-
fili sjaja piksela uzduž zelenih linija koje presjecaju zvijezdu prikazani su na slici 5.7 (liniju gore-lijevo
prema dolje-desno nazvali smo duža os, a liniju od dolje-lijevo prema gore-desno zovemo kraća os). Zelene
koncentrične kružnice su fotometrijske aperture različitih radijusa. Dvije velike plave kružnice označuju
prsten korišten za mjerenje pozadinskog sjaja neba. Primjetite i crvene linije koje se protežu po čitavoj
slici i po samoj zvijezdi. To su konture koje prate slijedeće vrijednosti piksela: 1630, 1700, 2000, 4000,
6000, 8000, i 10000. Te konture daju nam osjećaj kako na zvijezdi rastu vrijednosti piksela.

http://fotometrija.advega.hr/prirucnik/Primjer2-CR2.zip
http://fotometrija.advega.hr/prirucnik/Primjer2-CR2.zip
http://fotometrija.advega.hr/prirucnik/Primjer2-fits.zip
http://fotometrija.advega.hr/prirucnik/Primjer2-fits.zip
https://en.wikipedia.org/wiki/Double_Cluster
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Slika 5.7: Profil sjaja zvijezde A sa slike 5.6 uzduž dviju okomitih linija (nazvanih duža i kraća os).
Profili su prikazani zasebno za RGB komponente slike.

druga ima sjaj vrlo blizu sjaja neba na slici (zvijezda B). U ovoj vježbi pretpostavljamo da
ste prošli kroz prethodnu vježbu u poglavlju 5.1 i da stoga znate kako napraviti aperturnu
fotometriju. Jedina razlika je da ovaj puta bilježimo i broj piksela korištenih za mjerenje
medijama pozadinskog sjaja neba, ne bi li iskoristili formulu 2.25 za izračun pogreške
fotometrije. Obratite pažnju i na poglavlje 2.6.4 u kojem su upute kako tu pogrešku
propagirati na izračun pogreške izražene u magnitudama.

Analizu započnjemo sa zvijezdom A koja je prikazana na slici 5.6. Prvi dojam o zvijezdi
možemo dobiti kroz uvid u profil sjaja prikazan na slici 5.7. Zvijezda je toliko sjajna da
na profilima niti ne uočavamo varijacije u sjaju piksela neba jer su puno manjeg sjaja
od najsjajnijeg pixela zvijezde. Profili pokazuju tendenciju praćenja nekakvog pravilnog
oblika, ali postoje nepravilnosti koje vjerojatno dolaze iz procesa interpolacije vrijednosti
piksela uzrokovanog korištenjem Bayerove matrice na senzoru kamere (vidi opis što je to
u poglavlju 2.4.1).

Zatim krećemo u postupak fotometrije, ali na način da uzimamo niz različitih radijusa
aperture, od očito premalene koja pokriva samo nekoliko centralnih najsjanijih piksela,
pa do pretjerano velike koja daleko nadilazi samu veličinu zvijezde na slici. Te aperture
iscrtane su na slici 5.6 kao zelene koncentrične kružnice. Njihovu poziciju i radijus kon-
troliramo pomoću prozora koji se pojavi kada u progrmau DS9 kliknemo brzo dva puta
na kružnicu aperture (ili selektiramo aperturu i odaberemo Region→Get_Information).
Centar svih apertura držimo uvijek isti, a radijuse variramo od 2 do 20 piksela. Pritom
uvijek koristimo isti veliki prsten oko zvijezde (plave kružnice na slici 5.6) za izračun sjaja



5.2 Utjecaj veličine aperture na točnost fotometrije 65

Slika 5.8: Saj zvijezde A izmjeren fotometrijom po aperturama različitih radijusa (zelene koncentrične
kružnice na slici 5.6). Lijevi grafikon ima sjaj izražen u ukupnoj vrijednosti piksela, dok desni koristi sjaj
izražen u magnitudama. Fotometrijske pogreške iz jednadžbe 2.25 i poglavlja 2.6.4 su manje od simbola
na grafovima, ali stvarna pogreška određuje se analizom ovih grafikona opisanoj u tekstu.

pozadine.

Čemu ovakav set mjerenja? Zato jer očekujemo slijedeće. Kada je apertura vrlo mala,
fotometrija će očito podcijeniti sjaj zvijezde. Kako povećavamo aperturu tako mjereni sjaj
raste sve do radijusa unutar kojeg je obuhvaćeno svo svjetlo zvijezde. Daljnje povećanje
radijusa aperture trebalo bi davati uvijek isti sjaj. Vidimo na slici 5.8 da se upravo to i
dešava. Apertura radijusa od oko 9 piksela je prijelaz između ta dva trenda. Zanimljivo
da za veće aperture sjaj blago, ali konstantno, raste. Dva su moguća razloga.

• Možda veća apertura obuhvaća sve više piksela sjaja većeg od medijana pozadinskog
sjaja neba jer postoje dodatni, vrlo slabi, izvori svjetla okolo naše zvijezde. To je
zanimljiva tema za posebnu analizu o tome što je izvor pozadinskog šuma na slici.

• A možda imamo pogrešku u mjerenju medijana pozadinskog sjaja na slici. Vrijed-
nosti koje u ovom slučaju smo izmjerili su (1630,1632,1633) za filtere R, G i B. Ako
sve vrijednosti postavimo na 1633 (što je samo 0.18% korekcija u R filteru), krivulje
postaju gotovo savršeno ravne na grafovima na slici 5.8.

Što god da je razlog, iz ove analize grafikona sa slike 5.8 možemo procijeniti da nam je
sjaj zvijezde vrijednost dosegnuta kod aperture radijusa 9, i da pogreška neće prelaziti
±0.02 mag. Ali ova lakoća određivanja radijusa aperture na kojoj je doesgnut ukupni sjaj
zvijezde temelji se na tome da rezultat analize nije jako ovisio o pogrešci u određivanju
pozadinskog šuma na slici. Što ako je sjaj zvijezde vrlo slab i utjecaj šuma postane osjetan?

Takvu situaciju analiziramo kod naše zvijezde B. Na slici 5.9 prikazano je kako sada
postavljamo aperture, gdje bi radijus od 8 piksela trebamo biti dovoljan. Međutim ovdje
nailazimo na problem. Ako pogledate presjeke sjaja zvijezde prikazane na slici 5.10, možete
vidjeti kako je najsajniji piksel sada relativno malo iznad vrijednosti sjaja neba. To rezul-
tira velikim fotometrijskim greškama, što se vidi na slici 5.11. To se može shvatiti i time
što su razne nasumične oscilacije sjaja neba sada dovoljno velike da se vide na profilima
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Slika 5.9: Prikaz apertura u fotometrijskoj analizi zvijezde B (položaj na slici: x=3236, y=2394). Zelene
koncentrične kružnice su fotometrijske aperture radijusa 4, 6 i 8 piksela. Dvije velike plave kružnice
označuju prsten korišten za mjerenje pozadinskog sjaja neba. Radi lakšeg prikaza izgleda pozadinskog
šuma po RGB filterima, preklopili smo tri slike. Iz njih se vidi kako je granulacija najmanja u G filteru
jer u Bayerovoj matrici ima dva pixela (vidi poglavlje 2.4.1).

Slika 5.10: Profil sjaja zvijezde B sa slike 5.9 uzduž dviju okomitih linija (vodoravno i okomito na slici).
Profili su prikazani zasebno za RGB komponente slike.
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Slika 5.11: Saj zvijezde B izmjeren fotometrijom po aperturama različitih radijusa (zelene koncentrične
kružnice na slici 5.9). Gornji grafikoni imaju sjaj izražen u ukupnoj vrijednosti piksela, dok donji koriste
sjaj izražen u magnitudama. Fotometrijske pogreške iz jednadžbe 2.25 i poglavlja 2.6.4 su označene uz
svaku točku mjerenja. Crtkane linije su rezultat u situaciji kada korigiramo vrijednost pozadinskog sjaja
neba na slici (vidi tekst).

sjaja. To znači da svaki piksel koji je prikupljao svjetlo zvijezde ima u sebi i pogrešku
zbog tih nasumičnih oscilacija.

Koliki je to problem vidi se u tome da grafikoni na slici 5.11 više nužno ne prate
očekivani trend rasta i zatim konstantne vrijednosti kada su aperture dovoljno velike da
uključe čitavu zvijezdu. Sada se dešava da s većim aperturama izmjereni sjaj zvijezde
opada! Razlog takvom neočekivanom trendu je velika osjetljivost na preciznost mjerenja
pozadinskog sjaja neba. Mi uzimamo medijan vrijednosti piksela neba i dobijemo neki
cijeli broj. U ovom slučaju to su vrijednosti (1630, 1632, 1632) za RGB komponente
slike. Ako sada promijenimo vrijednosti u (1630, 1631.2, 1631.3), što je korekcija od samo
0.05%, krivulje na slici 5.11 se pomaknu na crtkane linije koje prate očekivani trend.
Ovakvim postupkom smo dobili veliku preciznost mjerenja pozadinskog sjaja, te dokaz
da je apertura radijusa 8 piksela uistinu dovoljna. Pogreška je ovaj puta dominirana
fotometrijskom pogreškom i iznosi otprilike (±0.03, ±0.04, ±0.05) magnitude po RGB
komponentama.
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5.3 Ubacivanje nebeskog koordinatnog sustava i prepozna-
vanje objekata na slici

U prvoj vježbi u poglavlju 5.1 morali smo prepoznati zvijezde koje se vide na našoj slici.
Za to smo koristili program Stellarium, gdje smo ručno uspoređivali mapu neba i našu
sliku. To je dobra vježba za upoznavanje neba, ali je vrlo neefikasan proces i uz to
podložan našim pogreškama. Za odraditi neki zahtjevniji zadatak potrebno je aktivirati
automatsko prepoznavanje objekata (zvijezde, galaksije) koji se vide na našoj slici. Time
ćemo se pozabavi u ovoj vježbi i otvoriti si prozor u svijet velike količine astronomskih
podataka koji čekaju da ih istražite.

U ovoj vježbi imamo zadatak da:

1. postavimo nebeski koordinatni sustav na našu sliku,
2. povežemo se kroz program DS9 sa SIMBAD bazom podataka, iz koje ćemo au-

tomatski povući podatke o zvijezdama vidljivim na našoj slici.

Ovdje podrazumijevamo da ste upoznati s konceptom nebeskog ekvatorskog koordinatnog
sustava u kojem svaka točka na nebu ima svoje koordinate rektascenziju (eng, right as-
cension) α i deklinaciju (eng. declination) δ. Astronomske slike u FITS formatu u svojem
zaglavlju (eng. header) mogu imati upisane podatke o tome kako je nebeski koordinatni
sustav preslikan na našu sliku. Taj zapis naziva se World Coordinate System (WCS) i
prvo ćemo ga morati postaviti na našu sliku. Tek nakon toga, zahvaljujući tim koordi-
natama, možemo krenuti povezivati objekte vidljive na našoj slici s objektima koji postoje
u astronomskim bazama podataka.

Astronomi su do danas kreirali mnoštvo velikih baza podataka o nebeskim objektima.
Jedna od njih je SIMBAD (https://simbad.cds.unistra.fr/simbad/) i biti će vam vrlo
korisna kao početniku u astronomiju. Sadrži preko 5 milijuna zvijezda i preko 5 milijuna
ne-zvijezdanih objekata (galaksija, maglica, itd.). Uz svaki objekt u bazi je pridruženo
mnoštvo informacija o tome što su sve astronomi do sada izmjerili i gdje se nalaze ti
podaci. Stoga će nam SIMBAD biti „prozor“ u svijet svemirskih podataka. A vidjet ćete
i da je to samo jedan od „prozora“ koji će vam program DS9 ponuditi.

Slijedite ovaj redosljed koraka:

• Za ovu vježbu koristit ćemo istu sliku kao i u prvoj vježbi u poglavlju 5.1. Potražite
u toj vježbi gdje skinuti sliku s našeg weba. Potrebna nam je u FITS formatu.

• Sada otvorite slijedeću web stranicu: https://nova.astrometry.net/upload. Radi
se o astronomskom projektu koji nudi besplatnu uslugu prepoznavanja područja neba
koje je vidljivo na vašoj slici. Kliknite „Browse“, odaberite sliku s vašeg računala, i
nakon toga kliknite „Upload“.

• Budući da je FITS slika velika, treba neko vrijeme da se učita, te nakon toga treba
malo pričekati da njihov program odradi proces prepoznavanja položaja zvijezda na
slici. Kada je gotov ispisati će poruku je li uspješno odradio posao, te nakon toga
kliknite na „Go to results page“. Tamo kliknite na „New FITS image“ i krenuti će
skidanje FITS slike koja ima umetnute podatke o WCS, tj. o koordinatnom sustavu.

• Sada tu novu FITS sliku učitajte u DS9. Slijedite upute iz poglavlja 5.1 kako si
podesiti „scale“ da zvijezde budu lijepo vidljive. No, odmah možete primjetiti jedan
novi detalj: kada mičete kursor preko slike, DS9 automatski sada prikazuje ne samo

https://simbad.cds.unistra.fr/simbad/
https://nova.astrometry.net/upload
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Slika 5.12: Slika na ekranu nakon što se aktivira prikaz nebeske koordinatne mreže.

Slika 5.13: Izgled ekrana nakon što je iz SIMBAD baze izvučen popis objekata koji se nalaze u zadanom
području slike.



70 Primjeri praktičnih projekata

Slika 5.14: Izgled ekrana nakon što smo filtrirali popis objekata iz SIMBAD baze. Kada kliknete ne neki
redak u tablici, taj objekat zasvijetli crveno na DS9 ekranu.

koordinate piksela na slici, nego i nebeske kooridnate α i δ.
• Koordinatni sustav slike prikazati će vam se na ekranu ako odaberete: Analysis→

Coordinate_Grid. Na slici 5.12 možete vidjeti kao to izgleda.
• Sada krećemo s pretragom objekata na slici. Odaberite Analysis→ Catalogs→

Database→ SIMBAD. Otvorit će se prozor u kojem sada treba unijeti kooridnate oko
koje će se pretraživati baza. Unesite α=0:46:06.76 i δ=+44:51:49.9, te Radius=10 ar-
cmin. Zatim kliknite na Retrieve na dnu prozora. Morate biti spojeni na Internet
jer u tom trenutku DS9 se povezuje sa SIMBAD bazom i traži objekte koji su unutar
Radius udaljenosti oko točke (α,δ). Kad je gotov, pojavit će se spisak objekata u
SIMBAD prozoru koji su ujedno iscrtani i na FITS slici. Stanje na ekranu vidi se
na slici 5.13.

• Popis objekata nadilazi kvalitetu naše slike, tj. preslabog su sjaja da budu vidljivi.
Uz to, nisu svi objekti zvijezde. SIMBAD ima svoju klasifikaciju objekata2, a mi
možemo fitrirati što nas zanima. U polje Filter u SIMBAD prozoru upišite [string
equal $OTYPE_S Star] i onda kliknite na gumb Filter na dnu prozora. Time ćete
selektirati samo objekte koji imaju klasifikaciju Star. Ako pak želite odabrati ob-
jekte koji nisu neki tip, npr. ne želite glakasije, unesite: ![string equal $OTYPE_S
Galaxy]. Ali mi želimo slijedeće:

- da objekt ima V magnitudu,
- da mu je V magnituda sjanija od 10.5 mag, te
- da se radi o tipu objekta Star.

Sva tri kriterija biti će zadovoljena ako upišete u filter: $FLUX_V && $FLUX_V<10.5
&& [string equal $OTYPE_S Star]. Nakon filtriranja stanje na ekranu je prikazano
na slici 5.14.

Ovime ste savladali minimum vještina prepoznavanja objekata na FITS slici, što će
nam biti korisno u idućim vježbama.

2Vidi spisak ovdje: http://vizier.u-strasbg.fr/cgi-bin/OType

http://vizier.u-strasbg.fr/cgi-bin/OType
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5.4 Ovisnost fotometrije o ekspoziciji i zašto koristiti de-
fokus

U poglavlju 4.2 smo se osvrnuli na problem saturacije sjajnih zvijezda, te kako se problem
može riješiti defokusiranjem slike. Ovdje ćemo demonstrirati to kroz primjer mjerenja
sjaja zvijezde Algol. Algol je zapravo trojni sustav zvijezda, gdje dvije sjajnije zvijezde
kruže jako blizu jedna druge. Kada veća, ali hladnija zvijezda od tih dviju prekrije svakih
2.86 dana drugu, sjaniju i topliju, mi na Zemlji vidimo to kao pad sjaja Algola s 2.1
magnituda na 3.4 magnitude u V.

U ovoj vježbi nas ne interesira praćenje varijabilnosti Algola, nego se bavimo osnovnim
pitanjem kako uopće fotometrirati tako sjajnu zvijezdu. U tu svrhu koristili smo fotoaparat
s objektivom i bez praćenja vrtnje neba. Budući da je zvijezda vrlo sjajna, čini se kao
lagani zadatak. Ne bi li istražili ponašanje fotometrije s različitim ISO i ekspozicijama,
napravili smo serijal slika koristeći ISO100, ISO200, ISO400 i ISO800, prilikom čega smo
varirali ekspoziicju od 0.01 sekunde do 4 sekunde.

Rezultati su vidljivi na slici 5.15. Koristimo G kanal RGB slike, budući da ima više
piksela od B i R kanala pa je precizniji, ali i zato što je sličan astronomskom V filteru.
Algol je saturirao kod svih slika s ekspozicijama u sekundama, a kod većih ISO i prilikom
kraćih od jedne sekunde. Kod vrlo kratih ekspozicija dolazimo do limita detekcije i greška
mjerenja raste. Te vrlo kratke ekspozicije nisu pogodne za fotometriju, ali nam ovdje služe
da demonstriramo efekte koji se pojavljuju kod sve kraćih ekspozicija.

Rješenje je, kao što smo naveli, u defokusu slike. Slika 4.4 prikazuje izgled slike
Algola koristeći ISO800 i ekspoziciju od 4 sekunde kada je slika fokusirana i defokusirana.

Slika 5.15: Fotometrija zvijezde Algol na slikama dobivenim fotoaparatom bez praćenja neba. Korištene
su različite ISO vrijednosti i ekospozcije od 0.01 sekundi do 4 sekunde. Zvijezda saturira sliku kod svih
ISO kada su ekspozcije u sekundama, ali ne i kada se slika defokusira.
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Slika 5.16: Fotometrija zvijezde Algol na slikama dobivenim fotoaparatom bez praćenja neba. Narančasta
linija su mjerenja na fokusiranim slikama, a plavo je rezultat kada je slika defokusirana. Korsitili smo
ISO800, a ekspozicija se kontinuirano mijenjala od 0.01 sekunde do 4 sekunde za fokusiranu i 10 sekundi
za defokusiranu sliku. Točke u obliku kružića su mjerenja. Situacije sa saturiranom zvijezdom označene
su praznim kružićima (istaknuo strelicama A), a bez saturacije s punim. Defokusirana mjerenja pokazuju
stabilni rast s dužinom ekspozicije (strelica B) kod ekspozicija od sekunde na više. Tek kod gotovo 10
sekundi dolazi do saturacije. Kada su ekspozicije manje, vrijednosti počinju oscilirati zbog seeinga, tj.
titranja u sjaju zvijezda uzrokovano atmosferom (istaknuto strelicama C). Kod vrlo kratkih ekspozicija
zvijezda je jedva uočljiva i fotometrija je podložna greškama zbog stapanja sa šumom (strelica D).

Fotometrijski rezultati na slici 5.15 daju naznaku da je fotometrija defokusirane slike
stabilna s povećanjem ekspozicije jer slika ne saturira. Stoga smo krenuli snimati Algol
iznova. Ovaj puta ISO je fiksiran na ISO800, a ekspozicije se kreću od 0.01 sekunde
do 10 sekundi. Rezultati su prikazani na slici 5.16. Defokusiranja slika saturira tek
s ekspozicijom od gotovo 10 sekundi, a stablina linearna ovisnost o dužini ekspozicije
pokazuje za ekspozicije od sekunde na više. Ekspozicije kraće od jedne sekunde pokazuju
oscilacije zbog atmosferskog seeing-a, što je i očekivano.

Budući da je Algol vrlo sjajna zvijezda na nebu, vidljiva i pod lošim uvjetima, a ujedno
i vrlo zanimljiv varijabilni objekt zbog jakih padova sjaja, preporučljiv je kao početni
objekt za učenička istraživanja. Kao što vidimo iz ovih vježbi, astronomija nije samo
"sirovo" mjerenje, nego i dubinsko razumijevanje ponašanje senzora, atmosfere, i statis-
tike. Isto tako, ova vježba je zoran primjer da se s običnim fotoaparatom, bez praćenja
i bez teleskopa može raditi zanimljiva astronomija koja zadire duboko u problematiku
astronomskih tehnika.
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5.5 Usporedba različitih načina konverzije u FITS format

Kao što smo već opisali u poglavlju 3.3, ako koristite fotoaparat onda su vam slike na
početku spremljene u sirovom formatu kojeg je potrebno konvertirati u FITS format. U
poglavlju 3.3.1 dajemo najjednostavniji način konverzije pomoću aplikacije ASTAP, a u
poglavlju 4.3.2 pomoću aplikacije IRIS. Ovdje ćemo još pokazati i kako pristupiti slikama
pomoću Python-a. Nezgodan detalj je što svi ti različiti načini konverzija nužno ne vode
u identičnu sliku. Pojavljuju se sitne razlike koje možda utječu na preciznost fotometrije.

5.5.1 Konverzija pomoću Python-a

Ako ste vični programiranju u Pythonu, onda vam može biti od interesa i uputa kako
fotografiju očitati u Python na način da imate pristup sirovim vrijednostima piksela. U
tu svrhu instalirajte si module rawpy i astropy (https://www.astropy.org/). Oni će vas
pratiti kroz rad u astronomiji u Pythonu. Zatim pokrenite slijedeću skripu:

1 import rawpy
2 from astropy .io import fits
3

4 filename = ’???? ’ # unesite naziv fotografije
5 outname = ’???? ’ # unesite naziv izlazne FITS slike
6

7 raw = rawpy. imread ( filename )
8 rgbraw = raw. raw_image
9

10 image = []
11 image. append ( rgbraw [1::2 ,::2]) # RED
12 image. append (0.5*( rgbraw [::2 ,::2] + rgbraw [1::2 ,1::2]) ) # GREEN
13 image. append ( rgbraw [::2 ,1::2]) # BLUE
14

15 rgb = fits. PrimaryHDU (data=image)
16 rgb. writeto ( outname )

Sirovoj slici pristupili smo pomoću raw.raw_image, ali dobiveno polje brojeva u sebi ima
piksele posložene po Bayerovoj matrici. Stoga moramo pristupiti pojedinačnim pikselima,
te je ovaj primjer podešen na primjer fotoaparata Canon EOS 60D (vidi sliku 5.17).
Primjetite da se zeleni piksel pojavljuje dva puta u Bayerovoj matrici, pa stoga jednostavno

Slika 5.17: Izgled Bayerove matrice za fotoaparat Canon EOS 60D s označenim indeksiranjem pristupa
pikselima u Pythonu (detaljnije o Bayerovoj matrici pronađi u poglavlju 2.4.1.)

https://www.astropy.org/
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Slika 5.18: Primjer rezultata konverzije fotografije u boji na RGB komponente u FITS formatu (korištena
je Python skripta iz poglavlja 5.5.1).

uzimamo njihovu srednju vrijednost kako bi ih uklopili u istu rezoluciju slike kao i plava
i crvena slika. Također, za razliku od konverzije pomoću ASTAP-a i IRIS-a, mi ovdje
ne radimo nikakvu interpolaciju3 pa je stoga konačna RGB slika duplo manjih dimenzija
nego li početa fotografija.

5.5.2 Usporedba FITS slika iz ASTAP-a, IRIS-a i Pythona

Sva tri pristupa stvaraju iskoristive FITS slike, ali zbog načina kako se odnose prema prob-
lemu Bayerove matrice rezultati se donekle razlikuju. Za početak, ASTAP i IRIS popunit
će sva 4 piksela Bayerove matrice s bojama koje nedostaju. Za to koriste matematiku
interpolacije i tu dolazi do nekih sitnih razlika, no slika bi trebala imati veličinu kao i u
originalu (ali i tu postoje odstupanja). U Python primjeru smo pokazali kako pristupiti
pikselima Bayerove matrice bez ikakvih interpolacija, te je zato konačna slika duplo manje
rezolucije.

Razlike koje se pojavluju demonstrirati ćemo primjerom sa slike 5.18. Istu fotografiju
smo konvertirali na tri različita načina i analizirali dobivene FITS slike. Dimnezije i
orijentacije FITS slika su navedene u tablici 5.2. Zatim smo usporedili histograme vri-
jednosti piksela, tj. iscrtali koliko često se pojavljuju pikseli određene vrijednosti. Slika
5.19 prikazuje histograme za FITS slike u B kanalu. Primjetite da postoje male razlike

3Kako bi dobili RGB sliku originalne rezolucije, pikseli koji su drugačije boje se popune nekim inter-
poliranim vrijednostima. Recimo, unutar 2x2 matrice B pixel se pojavljuje jednom, pa se stoga za B sliku
preostala tri piksela također popune nekim vrijednostima. Vidi poglavlje 2.4.1.

Tablica 5.2: Dimenzije FITS slika u usporedbi s originalnim formatom dobivene pomoću metoda iz
poglavlja 3.3.1, 4.3.2 i 5.5.1. Originalna fotografija načinjena je pomoću Canon EOS 60D fotoaparata.
Nakon konverzije dobivena FITS slika može imati inverziju po vertikalnoj osi (vidi sliku 5.19).

metoda rezolucija slike slika invertirana
originalni format 5184 x 3456 NE

ASTAP 5184 x 3456 DA
IRIS 5202 x 3465 NE

Python metoda 2672 x 1758 DA
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Slika 5.19: Histogrami vrijednosti piksela u B kanalu FITS slika dobivenih pomoću tri različite meotde
(poglavlja 3.3.1, 4.3.2 i 5.5.1). Dobivene slike su prikazane na svakom histogrmau. Histogram ima na x-osi
vrijednost piksela, a na y-osi koliko se često na slici pojavljuje takav piksel. Histogrami su izračunati i
scrtani u porgramu DS9 pomoću opcije Scale→Scale parameters.

koje vjerojatno imaju utjecaj ako želimo fotometriju vrlo visoke preciznosti. Međutim, za
takvu fotometriju nije poželjo niti koristiti fotoaparat, pa smo kao početnici u fotometriji
sasvim zadvoljni i ovakvim FITS slikama.

5.5.3 Utjecaj demozaik metode na PSF zvijezda

Ako koristimo fotoaparat i želimo podignuti preciznost fotometrije, onda moramo obratiti
pažnju na proces demozaika Bayerove matrice u RGB slike zapisane u FITS formatu.
Ukoliko vas ne zanima baviti se ovim detaljima, držite se uputa o konverziji u FITS
format iz poglavlja 3.3 ili 4.3.2. Tamo se ti paramtri fiksirani i možete s njima raditi bez
ulaženja u detalje.

Ako pak želite istražiti što se to točno dešava s vrijednostima piksela ovisno o demozaik
metodi, možete izraditi vježbu gdje uspoređujete rezultate fotometrije. Postoje razni al-
goritmi kojima se radi demozaik, ali osnovni problem je da za piksele koje popunjavamo
nemamo točnu informaciju o vrijednostima koje bi pikseli trebali imati. Najbolje što
možemo je raznim algoritmima predviđati koje bi to vrijednosti bile temeljem vrijednosti
piksela u boji koja mu je pridružena i susjednih piksela za koje znamo točne vrijednosti.
Algoritmima ćemo pomoći u preciznosti ako zvijezda pokriva nešto više piksela (preporču-
jemo 8-10 piksela u promjeru) i ako se usrednji rezultat fotometrije iz nekoliko uzastopnih
slika gdje se zvijezda malčice pomaknula od slike do slike.
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Slika 5.20: Usporedba zvijezde nakon konverzije kroz IRIS i ASTAP. Osim što koriste različite metode za
demozaik Bayerove matrice u RGB slike, ASTAP zrcali sliku po vertikalnoj osi (zato su zvijezde izdužene
u okomitim smjerovima), te drugačije podešava maksimalne vrijednosti piksela. Sjaj piksela na slikama je
obojan (Color→color u DS9) stepeničastom bojom da se lakše uoče promjene u sjaju.

Slika 5.20 ilustrira razliku koja postoji već na razini odbabira aplikacije za konverziju
u FITS format (IRIS ili ASTAP). Kao što smo opisali u poglavlju 4.3.2, u aplikaciji
IRIS možemo kontrolirati koju metodu za demozaik ćemo koristiti. Prilikom podešavanja
postavki kamere možemo birati između tri opcije pod RAW interpolation method: linear,
median i gradient. Slika 5.21 pokazuje jedan takav primjer usporedbe te tri metode.
Razlike su vrlo uočljive, a preporučamo da se za fotometriju koristi metoda linear.

Slika 5.21: Tri različite metode demozaika Bayerove matrice (gradient, median, linear) koje kontrolirate
opcijom RAW interpolation method opisanoj u poglavlju 4.3.2. Grafovi pokazuju sjaj piksela uzduž linija
na slikama ispod grafova. Zvijezda je u sva tri slučaja saturirana, ali oblik profila sjaja zvijezde (PSF) se
razlikuje ovisno o demozaik metodi. Sjaj piksela na slikama je obojan (Color→color u DS9) stepeničastom
bojom da se lakše uoče promjene u sjaju.
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